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Предисловие 
Благодарим Вас за приобретение этого изделия производства фирмы 
Topcon. Сведения, содержащиеся в этом руководстве (далее 
«руководстве») подготовлены фирмой Topcon Positioning Systems (далее 
«TPS») для владельцев изделий производства фирмы Topcon. Это 
руководство по эксплуатации было составлено для того, чтобы помочь 
использовать приемник при приведенных ниже условиях и положениях. 

Пожалуйста, внимательно ознакомьтесь с разделом 
“Условия и положения”. 

Условия и положения 
ПРОФЕССИОНАЛЬНОЕ ИСПОЛЬЗОВАНИЕ - Это изделие 
предназначено для профессионального использования. Пользователь 
был профессиональным геодезистом или человеком, хорошо 
осведомленным о геодезических работах, что необходимо для понимания 
указаний по применению и безопасности перед началом работы, поверки 
или настройки прибора. 
АВТОРСКИЕ ПРАВА - Все содержимое этого руководства является 
интеллектуальной собственностью фирмы TPS и защищено авторским 
правом. Все права сохранены. Запрещается использовать, получать 
доступ, копировать, хранить, отображать, использовать для создания 
составительских работ, продавать, изменять, публиковать, 
распространять, либо позволять третьей стороне получать доступ к 
любым рисункам, содержимому, информации либо данным из этого 
руководства без письменного разрешения TPS. Перечисленное выше 
содержимое может использоваться только для обеспечения 
использования приобретенного изделия. Информация и данные, 
содержащиеся в этом руководстве, являются ценным активом TPS, при 
создании которого были понесены существенные затраты труда, времени 
и денежных средств и являются плодом собственных усилий TPS по 
подборке, выбору и систематизации.
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ТОВАРНЫЕ ЗНАКИ NET-G3, Topcon Tools, Topcon Link, TopNET,  Topcon® 
и Topcon Positioning SystemsТМ являются товарными знаками или 
зарегистрированными торговыми марками TPS. Windows® является 
зарегистрированной торговой маркой Microsoft Corporation. Логотип 
Bluetooth® принадлежит Bluetooth SIG, Inc. и лицензирован Topcon 
Positioning Systems, Inc. Названия изделий или компаний, упомянутые в 
этом руководстве, могут быть товарными знаками соответствующих 
собственников. 
ОГРАНИЧЕНИЕ ГАРАНТИИ - ЗА ИСКЛЮЧЕНИЕМ ГАРАНТИЙНЫХ 
ОБЯЗАТЕЛЬСТВ И ЛИЦЕНЗИОННЫХ СОГЛАШЕНИЙ, ПРИЛАГАЕМЫХ К 
ИЗДЕЛИЮ И ПРИВЕДЕННЫХ В ПРИЛОЖЕНИИ К ЭТОМУ РУКОВОДСТВУ 
И НА ГАРАНТИЙНОЙ КАРТОЧКЕ, ПРИЛОЖЕННОЙ К ИЗДЕЛИЮ, ЭТО 
РУКОВОДСТВО И ИЗДЕЛИЕ ПОСТАВЛЯЮТСЯ “КАК ЕСТЬ”. 
ГАРАНТИЙНЫЕ ОБЯЗАТЕЛЬСТВА ДРУГОГО РОДА НЕ 
ПРЕДОСТАВЛЯЮТСЯ. ФИРМА TPS ОТКЛОНЯЕТ ЛЮБУЮ 
ПОДРАЗУМЕВАЕМУЮ ГАРАНТИЮ ТОВАРНОЙ ПРИГОДНОСТИ 
ИЗДЕЛИЯ ДЛЯ КАКОГО-ЛИБО КОНКРЕТНОГО ПРИМЕНЕНИЯ ИЛИ 
ИСПОЛЬЗОВАНИЯ. TPS И ЕЁ ПРЕДСТАВИТЕЛЬ НЕ 
НЕСУТ ОТВЕТСТВЕННОСТИ ЗА ТЕХНИЧЕСКИЕ ИЛИ РЕДАКТОРСКИЕ 
ОШИБКИ И ПРОПУСКИ, СОДЕРЖАЩИЕСЯ В ЭТОМ РУКОВОДСТВЕ, 
РАВНО КАК И ЗА УБЫТКИ СЛУЧАЙНЫЕ ЛИБО ЯВЛЯЮЩИЕСЯ 
ЗАКОНОМЕРНЫМ СЛЕДСТВИЕМ ПРИМЕНЕНИЯ, ИСПОЛЬЗОВАНИЯ 
ИЛИ ЭКСПЛУАТАЦИОННЫХ КАЧЕСТВ ЭТОГО РУКОВОДСТВА ИЛИ 
ИЗДЕЛИЯ. ТАКИЕ ОТКЛОНЯЕМЫЕ УБЫТКИ ВКЛЮЧАЮТ В СЕБЯ, НО НЕ 
ОГРАНИЧИВАЮТСЯ, ПОТЕРЯМИ РАБОЧЕГО ВРЕМЕНИ, УТЕРЕЙ ЛИБО 
ПОРЧЕЙ ДАННЫХ, УПУЩЕННОЙ ВЫГОДОЙ, ПОТЕРЯМИ ДЕНЕЖНЫХ 
СРЕДСТВ ЛИБО ДОХОДОВ, А ТАКЖЕ ПОТЕРИ ОТ ИСПОЛЬЗОВАНИЯ 
ИЗДЕЛИЯ. В ДОПОЛНЕНИЕ, TPS НЕ НЕСЕТ НИКАКОЙ 
ОТВЕТСТВЕННОСТИ И ОБЯЗАТЕЛЬСТВ ЗА УБЫТКИ ИЛИ ИЗДЕРЖКИ, 
ПОНЕСЕННЫЕ В СВЯЗИ С ЗАМЕНОЙ ИЗДЕЛИЯ ИЛИ ПРОГРАММНОГО 
ОБЕСПЕЧЕНИЯ, ИСКОВ ТРЕТЬИХ ЛИЦ, ВОЗМЕЩЕНИЯ НЕУДОБСТВ И 
ПРОЧИЕ РАСХОДЫ. В ЛЮБОМ СЛУЧАЕ TPS НЕ ДОЛЖНА НЕСТИ 
ОТВЕТСТВЕННОСТЬ ПО КОМПЕНСАЦИИ УБЫТКОВ ИЛИ РАСХОДОВ 
ПЕРЕД ВАМИ И ЛЮБОЙ ТРЕТЬЕЙ СТОРОНОЙ, ПРЕВЫШАЮЩУЮ 
ПРОДАЖНУЮ ЦЕНУ ПРИЕМНИКА. 

ЛИЦЕНЗИОННОЕ СОГЛАШЕНИЕ - Использование любого программного 
обеспечения («ПО»), поставляемого TPS, в том числе и загружаемого с 
интернет-сайта фирмы, должно производиться при принятии условий и 
положений, указанных здесь, и этого лицензионного соглашения. 
Пользователю предоставляется персональное, неисключительное, не 
подлежащее передаче другому лицу разрешение использовать (лицензия) 
это ПО на указанных здесь условиях для одного изделия или на одном 
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компьютере. Вы не можете передавать или переуступать ПО или это 
разрешение без специального письменного разрешения TPS. Разрешение 
действует до его окончания. Вы можете прекратить действие лицензии в 
любой момент, уничтожив ПО и это руководство. TPS может прекратить 
действие лицензии в том случае, если Вы не выполняете любое из этих 
условий или положений. Вы должны уничтожить ПО и это руководство 
после того, как Вы прекратите использовать приемник. Все права 
собственности, авторские права и права на интеллектуальную 
собственность в ПО принадлежат TPS. Если Вы не согласны с 
вышеперечисленными условиями, предлагаем Вам вернуть не бывшие в 
употреблении руководство и ПО. 
КОНФИДЕНЦИАЛЬНОСТЬ - Это руководство, его содержимое и ПО 
(далее упоминаемые как «конфиденциальная информация») являются 
конфиденциальной и составляющей собственность информацией TPS. 
Принимая условия этого соглашения, Вы берете на себя обязательства 
сохранять эту информацию таким же образом, как наиболее ценные 
коммерческие секреты своей организации. Тем не менее, этот параграф 
не ограничивает Вас в предоставлении информации, нужной по роду 
деятельности Вашим работникам, занимающимся использованием и 
обслуживанием изделия. Таковые работники также обязаны не 
разглашать конфиденциальную информацию. В том случае, если вы 
будете вынуждены по закону раскрыть конфиденциальную информацию, 
Вы должны немедленно известить TPS с тем, чтобы мы могли 
ходатайствовать об охранном судебном приказе или соответствующих 
средствах правовой защиты. 
ИНТЕРНЕТ-САЙТ И ПРОЧИЕ ЗАЯВЛЕНИЯ - Данные условия и 
положения (в том числе лицензионное соглашение на ПО, ограничение 
гарантии и ограничения ответственности) не могут быть изменены 
заявлениями, опубликованными на Интернет сайте TPS (равно как и на 
любом другом Интернет сайте), в рекламных материалах и изданиях TPS, 
либо сделанные работником TPS или независимым подрядчиком TPS. 
МЕРЫ БЕЗОПАСНОСТИ - Неправильная эксплуатация изделия Topcon 
может быть причиной телесных повреждений, порчи собственности и/или 
отказа изделия. Ремонт изделия должен производиться исключительно в 
центрах гарантийного ремонта, авторизованных Topcon. Пользователям 
следует ознакомиться с предупреждениями о технике безопасности, 
приведенными в руководствах, приложенных к изделию, и строго им 
следовать.  
РАЗНОЕ - Вышеупомянутые условия и положения могут быть в любой 
момент времени исправлены, изменены, заменены на другие либо 
отменены фирмой TPS. Вышеупомянутые условия и положения 
соответствуют и должны толковаться в соответствии с законами штата 
Калифорния без использования других юридических норм. 
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Соглашения, принятые в 
руководстве 
В этом руководстве использованы следующие обозначения: 
Обозначение  Описание  
File > Exit   Выберите пункт меню File (Файл), затем Exit  
    (Выход). 
Connection  Полужирным курсивным шрифтом выделено  
    название заголовков окон, в том числе диалоговых. 
Frequency  Курсивным шрифтом выделено название поля, 

 области или вкладки в диалоговом окне. 
Enter    Нажмите клавишу Enter (Ввод) клавиатуры. 
Примечание переводчика: названия отображаемых на английском языке 
элементов пользовательского интерфейса (названия пунктов меню, заголовков 
окон, кнопок, элементов списка и пр.) приведены в оригинальном виде, в скобках 
сразу за ними дан поясняющий перевод, пример см. выше. 

 

Дополнительные сведения о настройке и 
обслуживании системы 

 

  

Дополнительная информация, которая может помочь 
Вам при обслуживании и настройке системы. 

 
Дополнительная информация о факторах, которые 
могут оказать влияние на работу системы, ее 
технические характеристики, результаты измерений 
или личную безопасность. 

 
Уведомление о том, что операция может оказать 
неблагоприятное воздействие на работу системы, ее 
технические характеристики, целостность данных 
или личное здоровье. 

 

 

Предупреждение о том, что операция повредит 
систему, вызовет потерю данных, потерю гарантии 
или вред здоровью. 

 

 

Предупреждение о том, что это действие нельзя 
выполнять ни при каких обстоятельствах. 
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Глава 1  
Введение 

 

Приемник NET-G3 (см. рисунок 1-1 на странице 1-2) является 
многодиапазонным приемником GNSS, специализированным для 
использования в качестве опорной (базовой) станции. Приемник 
предназначен для использования в качестве постоянно функционирующей 
опорной станции для рынка высокоточных измерений. Под таким рынком 
подразумевают рынок оборудования, подсистем, компонентов и 
программного обеспечения, предназначенный для геодезической съемки, 
строительства, коммерческого картографирования, гражданской 
инженерии, сельскохозяйственных задач, требующих высокой точности, 
строительства наземных сооружений, управления сельскохозяйственной 
техникой, фотограмметрического картографирования, гидрографии и 
любых других задач, решаемых соответствующими средствами. 
Приемник NET-G3 может принимать и обрабатывать разнообразные 
сигналы (включая стандартизованные в последнее время сигналы GPS 
L2С, L5, GLONASS C/A L2 и GALILEO), что повышает точность 
определения координат пунктов наблюдения, особенно в 
неблагоприятных условиях приема спутниковых сигналов. Перечисленные 
ниже возможности обеспечивают навигационное определение, 
удовлетворяющее требованиям любого высокоточного вида съемки: 

• GNSS 

• Прием сигналов нескольких поддиапазонов 

• Выход сигнала ежесекундной метки (PPS, Pulse Per Second) и 
определение момента внешнего события 

• Вход подключения внешнего генератора и выход внутреннего 
опорного генератора 

• Поддержка сетевых соединений 
Дополнительные возможности, в том числе подавление влияния 
многолучевого распространения, обеспечивают прием слабых сигналов, 
даже под кронами деревьев. Приемник обеспечивает функциональность, 
точность, доступность и целостность, необходимые для быстрого и 
эффективного сбора данных и управления ими. 
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Рисунок 1-1. Приемник NET-G3 

Принцип действия 
Спутниковая съемка, выполненная с помощью одной базовой станции или 
сети базовых станций, с использованием высокоточных GNSS измерений 
обеспечивает высочайший уровень точности определения 
местоположения. 
В этом разделе дается краткое описание функционирующих и 
планируемых к развертыванию Глобальных Навигационных Спутниковых 
Систем (ГНСС - GNSS) и работе приемника, что поможет понять и 
правильно применять эти знания на практике и позволит использовать 
приемник максимально эффективно. 

Обзор ГНСС 
В настоящее время услуги определения местоположения, скорости и 
времени предоставляют три глобальные навигационные спутниковые 
системы (ГНСС). Все эти системы всепогодные, работают круглосуточно и 
доступны в любой точке на поверхности Земли и в околоземном 
пространстве любому пользователю, имеющему приемник сигналов ГНСС. 

• GPS (Global Positioning System) – финансируется и управляется 
министерством обороны Соединенных Штатов Америки. Для 
получения информации о текущем состоянии системы посетите 
интернет-сайты обсерватории ВМФ США <http://tycho.usno.navy.mil/> 
и службы береговой охраны США (http://www.navcen.uscg.gov/).
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• ГЛОНАСС (Глобальная Навигационная Спутниковая Система) – 
финансируется и управляется министерством обороны Российской 
Федерации. Для получения информации о текущем состоянии 
системы посетите интернет-сайт Координационного Научного 
Информационного Центра (http://www.glonass-center.ru/frame_e.html). 

• GALILEO – система определения местоположения, развертываемая 
в настоящее время, финансируется и управляется Galileo Industries 
(Галилео Индастриз), совместным предприятием космических 
агентств нескольких европейских стран, тесно сотрудничающих с 
европейским космическим агентством. В отличие от GPS и 
ГЛОНАСС, эта система изначально предназначена для 
гражданского использования. В настоящий момент она находится на 
этапе проектирования и прототипирования. Для получения 
информации о текущем состоянии системы посетите интернет-сайт 
Galileo Индастриз (http://www.galileo-industries.net). 

Несмотря на многочисленные различия технологического характера, все 
системы определения местоположения состоят из трех компонентов: 

• Космический сегмент – спутники GPS, ГЛОНАСС и Galileo 
обращаются по околокруговым орбитам высотой около 20 000 км 
над поверхностью Земли, снабжены радиопередатчиками и 
высокоточными хранителями времени. Каждый из этих спутников 
передает свои орбитальные параметры (эфемериды), альманах 
системы (параметры орбиты всех остальных спутников), параметры 
коррекции времени бортовых часов и другую информацию. 

• Сегмент управления – наземные измерительные пункты, 
расположенные в различных частях Земли, отслеживающие 
спутники и закладывающие в них данные о поправках бортовых 
часов и обновленные эфемериды для обеспечения достоверности 
передаваемой со спутников информации. 

• Пользовательский сегмент – гражданские и военные пользователи, 
оснащенные приемниками ГНСС, используют измерения, 
выполненные по этим сигналам, для вычисления своего 
местоположения. 

Вычисление местоположения 
При вычислении местоположения движущийся или неподвижный 
приемник определяет пространственные координаты в трехмерной 
системе координат, связанной с центром масс Земли и неподвижной 
относительно нее. Чтобы определить свои координаты, приемник 
измеряет расстояния (называемые псевдодальностями в связи с тем, что 
хранитель времени приемника изначально не синхронизирован с 
общесистемной шкалой времени) до четырех или более спутников. В 
измеренные псевдодальности вносятся поправки за разность шкал 
времени спутника и общесистемной шкалы, предсказанные задержки из-за 
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распространения сигнала в атмосфере и др. Положения спутников 
вычисляются по эфемеридам, передаваемым ими в навигационных 
сообщениях. При использовании одной спутниковой системы для 
определения координат необходимо не менее четырех спутников. При 
использовании нескольких систем (GPS, ГЛОНАСС, Galileo) приемник для 
получения местоположения должен принимать сигналы как минимум пяти 
спутников в связи с различиями временных шкал, используемых в этих 
системах. 

Определение относительного 
(дифференциального) местоположения 
DGPS, или дифференциальная GPS – это методика определения 
относительного местоположения, в которой измерения, одновременно 
производимые двумя или более разнесенными в пространстве 
приемниками, обрабатываются совместно с помощью сложных 
алгоритмов, что позволяет определить относительные координаты 
фазовых центров антенн этих приемников с высокой точностью. 
DGPS реализуется разными способами, которые могут быть 
классифицированы по следующим параметрам: 

• По типу основных используемых измерений GNSS – задержка 
кодовой последовательности или отсчету фазы несущей. 

• Определяются ли результаты в реальном времени или при 
камеральной обработке. 

При работе в режиме DGPS один приемник, называемый опорным 
приемником или базовой станцией, размещается на пункте с известными 
координатами. Другой приемник, называемый удаленным или подвижным 
приемником, размещается на пункте, координаты которого требуется 
определить. Опорная станция производит измерения дальностей до всех 
доступных спутников и рассчитывает разности (поправки) между 
результатами этих измерений и дальностями, вычисляемыми по 
известным координатам точки стояния. 

• Для приложений реального времени эти поправки и координаты 
опорной станции затем приводятся к стандарту RTCM (или 
фирменным форматам передачи данных) - и передаются на 
удаленный приемник (и) с использованием канала передачи данных. 
Удаленный приемник использует собственные измерения и 
корректирует их принятыми поправками. 

• Для приложений с камеральной обработкой синхронные измерения, 
произведенные на опорных и подвижных станциях, обычно 
записываются на внутреннюю память приемника и не пересылаются 
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по каналу передачи данных. После окончания сеанса измерений 
данные копируются в компьютер и обрабатываются совместно. 

При применении этой методики влияние искажающих измерения 
пространственно коррелированных факторов (например, погрешностей 
предсказания положений спутников, задержек при прохождении сигнала в 
ионосфере и тропосфере) могут быть существенно снижены, что 
позволяет определить точное относительное местоположение. 
Существует несколько реализаций дифференциального способа 
определения координат, в том числе съемка с камеральной обработкой, 
съемка в кинематическом режиме в реальном времени, съемка с 
использованием сигналов береговых радиомаяков, геостационарных 
спутников (например, сети OmniSTAR), а также системы спутникового 
дополнения (WAAS, EGNOS, MSAS). 
Наиболее точным методом съемки в реальном времени является метод 
RTK (кинематическая съемка в реальном времени). В этом методе 
используются, по крайней мере, два приемника и канал передачи данных 
между ними. Как правило, один из приемников (база) устанавливается над 
точкой с известными координатами, другой (подвижный) – над 
определяемой точкой. Базовый приемник производит измерения по фазе 
несущей частоты, вычисляет RTK-поправки и передает эти данные на 
подвижный приемник. Последний обрабатывает полученные данные 
вместе со своими собственными измерениями фазы несущей и 
определяет свое положение относительно базы с точностью до 1 см в 
плане и 1.5 см по высоте (для разных типов приемников эти показатели 
могут отличаться). 

Получение точного и надежного 
местоопределения 
Получение надежного и точного местоопределения возможно при 
соблюдении приведенных ниже условий: 

• Точность - точность местоположения зависит, прежде всего, от 
геометрии спутников (характеризуется геометрическим фактором 
ухудшения точности – GDOP) и погрешностей измерения дальности 
до спутников.  

- Дифференциальный режим GPS (DGPS и RTK) в значительной 
степени позволяет скомпенсировать погрешности, вызванные 
прохождением сигналов в атмосфере и неточностью 
предсказания орбит спутников, и устраняет искусственное 
загрубение спутниковых сигналов, применяемое министерством 
обороны США. 

- Чем больше спутников в поле зрения и чем меньше величина 
геометрического фактора, тем выше точность 
местоопределения. 
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• Доступность – доступность спутников влияет на достоверность 
вычисленного местоположения. Чем больше видимых спутников, 
тем выше точность и достоверность вычисления местоположения. 
Естественные и искусственные объекты могут блокировать, 
прерывать и ослаблять сигналы, снижая число видимых спутников и 
ухудшая условия приема сигналов. 

• Целостность – отказоустойчивость позволяет полагать, что 
местоопределение определяется надежно и точно. 
Отказоустойчивость обеспечивается сочетанием перечисленных 
ниже факторов и методов: 

- Автономный контроль целостности приемником (RAIM) 
позволяет определить отказавшие спутники GNSS и исключает 
данные этих спутников из вычислений местоположения.  

- Наличие не менее пяти видимых спутников при работе по 
одному из созвездий GPS или ГЛОНАСС; не менее шести 
спутников при работе по обоим созвездиям. 

- Широкозонная дифференциальная подсистема (WAAS, EGNOS 
и др.) вырабатывает и передает наряду с дифференциальными 
поправками (DGPS), данные о целостности информации 
(например, сообщения о состоянии спутников).  

- Достоверные данные эфемерид и альманаха. 

Выводы 
В данном кратком обзоре приведены только основы местоопределения по 
спутниковым навигационным системам. Более подробную информацию 
можно найти на интернет-сайте TPS. 

Функционирование приемника 
В приемнике NET-G3 применена новая, самая современная технология 
слежения за спутниковым сигналом под названием G3, позволяющая, в 
том числе, изменять алгоритмы реализации цепей слежения за сигналами 
(спецификации которых подвергаются изменениям) через простые 
обновления встроенного программного обеспечения, что в максимальной 
степени обеспечивает защиту капитальных вложений. 
После окончания процесса самотестирования при подаче напряжения 
питания все 72 канала приемника инициализируются и начинают 
отслеживать сигналы видимых над горизонтом навигационных спутников. 
Каждый канал приемника может быть использован для слежения за 
любым сигналом спутниковых навигационных систем GPS, ГЛОНАСС или 
GALILEO. Большое число каналов приемника позволяет вести слежение 
одновременно за всеми видимыми спутниками ГНСС в любом месте и в 
любое время. 
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Внешняя навигационная спутниковая антенна, оборудованная 
малошумящим усилителем, и высокочастотный тракт приемника 
соединены коаксиальным кабелем. Принимаемый широкополосный сигнал 
преобразуется с понижением частоты, фильтруется, оцифровывается, и 
передается для обработки измерительным каналам. Центральный 
процессор приемника управляет слежением за спутниковыми сигналами. 
Как только в канале произошел захват сигнала, он демодулируется, и 
измеряются параметры сигнала (фазы кода и несущей). Из сигнала 
выделяется передаваемый спутником поток данных. 
После захвата приемником четырех и более спутников становится 
возможным произвести автономное (без привлечения дополнительной 
информации) местоопределение – т.е. вычислить координаты приемника в 
системе координат, используемой спутниковой навигационной системой и 
величину расхождения шкал времени, задаваемых системой и внутренним 
генератором приемника. Все данные измерений можно сохранить на 
(поставляемой дополнительно) карте памяти формата Compact Flash и 
позже загрузить в компьютер для камеральной обработки с 
использованием соответствующего пакета программ. Когда приемник 
находится в режиме RTK, данные измерений также могут быть записаны 
на карту памяти приемника, что позволяет произвести контрольную 
камеральную обработку полевых измерений. 
Приемник обладает следующими функциями (некоторые следует 
заказывать специально): 

• Подавление многолучевости; 
• Использование широкозонной подсистемы (WAAS, EGNOS и т.п.); 
• Настройка параметров контуров слежения за фазой и задержкой; 
• Двухчастотные режимы статической, кинематической, 

кинематической в реальном времени (RTK) и дифференциальной 
(DGPS) съемки; 

• Выход сигнала ежесекундной метки времени и определение 
момента внешнего события 

• Вход подключения внешнего генератора и выход внутреннего 
опорного генератора 

• Поддержка сетевого соединения Ethernet 
• Автоматическая запись данных; 
• Установка набора значений минимального угла возвышения; 
• Установка наборов параметров съемки; 
• Статические и динамические режимы измерений; 
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Ознакомление 
Поставляемая стандартно конфигурация приемника NET-G3 включает в 
себя следующее: 
• 72 канальный приемник GNSS • Разъем для подключения 

внешней антенны GPS 
• 4 последовательных порта • Разъем для подключения 

внешнего генератора 
• Порты USB и Ethernet • Разъем вывода сигнала 

ежесекундной метки и ввода 
маркера внешнего события 

• Интерфейс управления и 
отображения состояния сбора 
данных 

• Два разъема питания 

• Разъем подключения карт CF  
Некоторые из указанных выше опций должны быть разрешены для 
использования в файле авторизации опций. Подробнее см. раздел “Файл 
авторизации опций (OAF)” на странице 1-18. 
Стандартный комплект приемника NET-G3 включает в себя набор 
кабелей, адаптер питания, компакт диск “Topcon GPS+”с программным 
обеспечением, карту памяти формата Compact Flash и документацию. 

Приемник NET-G3 
Использование приемника NET-G3 обеспечивает надежное и 
эффективное (в том числе, и по стоимости)  развертывание сетевой 
инфраструктуры в ограниченные сроки. Этот прибор управляется при 
помощи специализированного языка программирования GPS Receiver 
Interface Language (GRIL) и оснащен большим набором интерфейсов 
подключения, что предоставляет большие возможности: 

• В выборе управляющего программного обеспечения, включая PC-
CDU, TopNET и собственные программы, разрабатываемые 
пользователем. 

• В использовании разнообразных интерфейсов, позволяющих 
подключить приемник к внешним устройствам, в т.ч. компьютерам, 
оборудованию компьютерных сетей, датчикам, источникам опорной 
частоты и т.д. 
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MINTER 
MINTER - это пользовательский интерфейс приемника, предназначенный 
для отображения состояния и контроля ввода/вывода (см. рисунок 1-2). 
Светодиод (СИД) STAT отображает состояние обнаруженных спутников. 

• Мерцает красным - приемник включен, но спутники не обнаружены. 

• Мерцает зеленым – приемник включен и обнаруживает спутники: 
одна вспышка на один спутник GPS. 

• Мерцает оранжевым – приемник включен и обнаруживает спутники: 
одна вспышка на один спутник ГЛОНАСС. 

Светодиод (СИД) LINK отображает состояние интерфейса Ethernet. 

• Непрерывно светится зеленым цветом – установлено соединение 
через Ethernet. 

• Не горит - соединение через Ethernet не установлено 

СИД STAT СИД LINK СИД PWR Кнопка FN

Кнопка Питание

СИД REC СИД RX/TX  
Рисунок 1-2. MINTER приемника NET-G3 
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Светодиоды PWR отображают состояние питающего напряжения, 
подаваемого по соответствующему порту, расположенному на задней 
панели прибора. 

• Непрерывно светится зеленым цветом – приемник использует 
питание по этому порту и напряжение находится в рабочем 
диапазоне от 6 до 28 Вольт постоянного тока. 

• Непрерывно светится желтым цветом – по этому порту к приемнику 
поступает напряжение в рабочем диапазоне от 6 до 28 Вольт 
постоянного тока, но данный порт для питания не используется. 

• Непрерывно светится красным цветом – напряжение на этот порт 
питания не подается. Подробное описание см. в разделе ”Отказы 
системы питания” на странице 5-3. 

Светодиод REC отображает состояние записи данных. Подробное 
описание поведения этого светодиода при использовании кнопки FN см. в 
разделе “Кнопка FN” на странице 1-11. 

• Вспыхивает зеленым цветом – каждое вспышка соответствует 
моменту записи на карту памяти CF. 

• Непрерывно светится оранжевым цветом – приемник изменяет 
режим работы. 

• Вспыхивает оранжевым цветом – показывает, что приемник 
проверяет свою внутреннюю файловую систему (после очистки 
NVRAM или загрузки нового программного обеспечения). Во время 
этой операции файловая система недоступна для программ 
дистанционного управления и для записи информации. Эта 
операция продолжается от доли секунды до нескольких минут, в 
зависимости от размера CF карты и других факторов. 

• Непрерывно светится красным цветом – отображает неисправность 
приемника (нехватка памяти, не вставлена CF карта, аппаратный 
отказ или неправильный файл OAF). 

Таблица 1-1 на странице 1-11 описывает состояние светодиода REC при 
использовании кнопки FN  
Светодиод RX TX отображает статус встроенного радиомодема. В 
текущей модификации прибора этот светодиод не используется. 
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Кнопка FN (ФУНКЦИЯ) переключает приемник между режимами 
информации и записи данных, позволяет начать и остановить запись 
данных и установить скорость передачи данных по последовательному 
порту на стандартное значение 9600 Бод. Подробное описание см. в 
разделе “Использование MINTER” на странице 3-21.  
Таблица 1-2 на странице 1-14 описывает работу светодиода REC при 
использовании кнопки FN. 

Таблица 1-2. Операции кнопки FN и состояние светодиода REC. 

Кнопка FN Светодиод REC Состояние 

Когда данные не записываются, и кнопка FN… 

Красный Нет свободной памяти, аппаратный 
отказ при записи данных. 

Режим кнопки FN – переключение режима светодиода 
Зеленый Запись данных началась (режим 

камеральной обработки не 
определен). 

Режим кнопки FN – изменение режима съемки 
Зеленый Запись данных началась (режим 

камеральной обработки - 
кинематический). 

Не нажата 

Оранжевый Запись данных началась (режим 
камеральной обработки - 
статический). 

Режим кнопки FN – переключение режима светодиода 
Оранжевый Режим сменится при отпускании 

кнопки. 
Режим кнопки FN – изменение режима съемки Нажата менее одной 

секунды Оранжевый При отпускании кнопки происходит 
смена режима со статического на 
кинематический и обратно. 

Нажата от одной до 
пяти секунд 

Не светится При отпускании кнопки запись 
данных прекращается. 

Нажата от пяти до 
восьми секунд 

Красный При отпускании кнопки для порта A 
устанавливается скорость обмена 
9600 Бод 

Нажата более 
восьми секунд 

Не светится Действие не производится (данные 
записываются). 
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Таблица 1-2. Операции кнопки FN и состояние светодиода REC (продолжение). 
Кнопка FN Светодиод REC Состояние 

Когда данные записываются, и кнопка FN… 

Красный Нет свободной памяти, аппаратный 
отказ при записи данных. 

Режим кнопки FN – переключение режима светодиода 
Зеленый Запись данных началась (режим 

камеральной обработки не 
определен). 

Режим кнопки FN – изменение режима съемки 
Зеленый Запись данных началась (режим 

камеральной обработки - 
кинематический). 

Не нажата 

Оранжевый Запись данных начата (режим 
камеральной обработки - 
статический). 

Режим кнопки FN – переключение режима светодиода 
Оранжевый Режим сменится при отпускании 

кнопки. 
Режим кнопки FN – изменение режима съемки Нажата менее одной 

секунды Оранжевый При отпускании кнопки происходит 
смена режима со статического на 
кинематический и обратно. 

Нажата от одной до 
пяти секунд  

Не светится При отпускании кнопки запись 
данных прекращается. 

Нажата от пяти до 
восьми секунд 

Красный При отпускании кнопки для порта A 
устанавливается скорость обмена 
9600 Бод 

Нажата более 
восьми секунд 

Не светится Действие не производится (данные 
записываются). 

 
Кнопка PWR (Питание) используется для включения и выключения 
приемника. 
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Порты данных и питания 
В приемнике NET-G3 разъемы портов размещены на передней и задней 
панелях. 
На передней панели расположены два разъема (см. рисунок 1-3): 

• Последовательного интерфейса (7-и штырьковый ODU-MINI-SNAP), 
используется для подключения к приемнику внешних устройств - 
порт А приемника. 

• USB (Mini-B) – используется для высокоскоростной передачи данных 
и связи между приемником и внешним устройством. Этот порт 
расположен под крышкой. 

Разъем 
последовательного 

порта
Разъем порта USB

(расположен под крышкой)

 
Рисунок 1-3. Передняя панель приемника NET-G3 

На задней панели приемника расположены следующие десять разъемов 
(см. рисунок 1-4 на странице 1-14): 

• Последовательные порты (9 pin D-shell) используются для связи 
между приемником и внешними устройствами. 

• Порт Ethernet (12 pin ODU-MINI-SNAP) используется для 
подключения приемника к компьютерной сети. 
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• Разъем 1PPS (Тип BNC) предназначен для вывода секундного 
импульса с программируемым опорным временем, периодом и 
смещением. Импульс синхронизирован с заданным опорным 
временем. 

• Разъем маркера внешнего события (Тип BNC) используется для 
входа внешнего импульса. 

• Антенный разъем (Тип N) используется для подключения антенны 
ГНСС. 

• Разъем подключения внешнего генератора (Тип BNC) предназначен 
для подключения внешнего стандарта опорной частоты. 

• Порты питания (5 pin ODU-MINI-SNAP) – используются для 
подключения приемника к внешним источникам электропитания. 

 
Антенна 1 PPS Последовательный Питание

Внешний генератор
Внешнее
событие EthernetПоследовательный

 
Рисунок 1-4. Задняя панель приемника NET-G3 

Слот карты памяти 
Слот для карты памяти формата CF расположен на передней панели 
приемника под крышкой (см. рисунок 1-5 на странице 1-15) и используется 
для подключения приобретаемой отдельно карты памяти к плате 
приемника для записи измерительных данных. Установленная карта 
памяти обычно остается внутри приемника. Доступ к данным 
осуществляется по последовательным, USB или Ethernet портам. Карта 
памяти Compact Flash может быть приобретена в вашем местном 
магазине компьютерных товаров. Ознакомьтесь, пожалуйста, с разделом 
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“Карты памяти CF, пригодные к использованию с NET-G3” на странице A-
16, где указан список рекомендованных карт памяти, успешно прошедших 
тестирование с NET-G3. Для получения информации об использовании 
карт памяти других производителей обратитесь в службу поддержки TPS. 

Кнопка слота карты
Слот карты CF

 
Рисунок 1-5. Слот карты памяти NET-G3 

Отверстия для крепления 
С нижней стороны в корпусе приемника выполнены четыре отверстия для 
крепления с резьбой #8-32 (см. рисунок 1-6). Крепление приемника на 
винты препятствует нежелательным смещениям. 

 
Рисунок 1-6. Крепежные отверстия NET-G3 
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Кабели и адаптер питания 
Комплект приемника NET-G3 включает стандартные интерфейсные 
кабели и кабели питания, позволяющие настроить приемник и обеспечить 
его питанием. Таблица 1-2 перечисляет кабели, включенные в комплект 
NET-G3. 

Таблица 1-2. Кабели в комплекте NET-G3 

Описание Внешний вид кабеля 
Кабель USB 

Соединяет приемник с внешним 
устройством (контроллером или 
компьютером) для высокоскоростной 
передачи информации и настройки 
приемника. 
p/n 14-008070-01 
Может быть приобретен в 
компьютерном магазине.  

Кабель RS232 соединяет 
последовательный порт приемника и 
внешнее устройство. Колпачок 
разъема черного цвета. 
 
p/n 14-008005-03 

 

Ethernet адаптер служит для 
подключения приемника к сети 
Ethernet (через патч-корд и кросс 
патч-корд). 
p/n 14-008085-01 

Кабель 1PPS, маркера события, 
входа или выход внешней 
частоты  
соединяет разъемы 1PPS, EVENT 
события или EXT FREQ с 
соответствующим разъемом 
внешнего устройства. 
p/n 14-008010-01  
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Нуль-модемный кабель  
Предназначен для подключения 
внешнего устройства (контроллера 
или компьютера) к приемнику  для 
передачи данных и приема настроек 
конфигурации. 

p/n 14-008086-01 

Может быть приобретен в 
компьютерном магазине 

 
Кабель питания для подключения 
сетевого адаптера к сети 
переменного тока 220 В. 
 
p/n 14-008052-01 – для США 
p/n 14-008053-01 – для Европы 

Адаптер питания используется как 
внешний источник питания. Этот 
блок преобразует сетевое 
напряжение переменного тока в 
напряжение постоянного тока, 
используемое для питания 
приемника. 
p/n 22-034101-01 

Кабель питания приемника 
используется для подключения 
приемника к внешнему источнику 
питания с разъемом SAE. Колпачок 
разъема красного цвета. 
 
p/n 14-008016-03 
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Кабель питания с разъемом на 
одном конце используется для 
подключения к кабелю питания 
через разъем SAE произвольного 
источника питания. 
p/n 14-008094-01 

 

Прочие принадлежности 
В комплект NET-G3 включаются: карта памяти CF емкостью 512 Мб, 
компакт-диск с ПО настройки, плавкий предохранитель и документация. 

 
Рисунок 1-7. Принадлежности, входящие в комплект NET-G3 

Поставщик оборудования проконсультирует Вас по вопросам, касающимся  
дополнительных принадлежностей и вариантов комплектации приемника 
NET-G3. 

Файл авторизации опций (OAF) 
Topcon Positioning Systems выпускает файлы авторизации опций (Option 
Authorization File, OAF) для того, чтобы пользователь получил 
возможность использовать приобретенные им опции. Файл авторизации 
опций (OAF) позволяет покупателям настраивать и конфигурировать 
приемник под выполнение конкретных задач, так что остается лишь 
приобрести необходимые опции. 
Обычно в поставляемый с завода приемник вносится временный OAF, 
который можно использовать только в установленный период времени. 
Когда приемник приобретен, новый OAF включает заказанные и 
оплаченные опции на постоянной основе. Возможности приемника 
остаются без изменений после очистки энергонезависимого ОЗУ или 
перезагрузке приемника. 
OAF предоставляет возможность воспользоваться следующими видами 
функций. Для получения полного списка возможных опций и их описания 
посетите сайт TPS или проконсультируйтесь с Вашим дилером Topcon.
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• Тип сигнала (стандарт – L1, дополнительно –  L2, L5 GPS, ГЛОНАСС, 
GALILEO). 

• Внешняя карта памяти CF. 

• Темп обновления данных (стандартно 1 Гц, дополнительно 5, 10 или 
20 Гц). 

• RTK в 1, 5, 10 и 20 Гц. 

• RTCM/CMR вход/выход. 

• Сигнал 1PPS. 

• Вход маркера внешних событий. 

• Вход/Выход опорной частоты. 

• Ethernet. 

• FTP. 

• Усовершенствованное подавление многолучевости. 

• Широкозонная дифференциальная подсистема (WAAS). 

• Контроль целостности автономным приемником (RAIM). 
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Для заметок: 
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Глава 2  
Подготовительные 
работы 
Успешное развертывание и функционирование базовой станции, 
построенной на основе приемника NET-G3, требует тщательного выбора 
места, анализа обстановки и правильной настройки оборудования. Эти 
условия являются наиболее важными для оптимизации работы приемника 
и включения его в существующую сеть или при создании новой сети. 

После выбора места размещения приемника Вы можете приступить к 
установке оборудования и программного обеспечения, необходимого для 
настройки и управления приемником NET-G3. Для настройки приемника 
используйте специализированное программное обеспечение. Перед 
началом работы соберите альманах и эфемериды. Детальное описание 
этих операций приводятся в разделах: 

• "Выбор места размещения базовой станции” на странице 2-2. 

• ”Установка программ Topcon” на странице 2-5. 

• "Установка CF карты" 2-7. 

• "Питание приемника” на странице 2-8. 

• "Сбор альманахов и эфемерид” на странице 2-10. 

• "Подключение приемника к компьютеру” на странице 2-11. 

• "Управление питанием” на странице 2-19. 
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Выбор места размещения 
базовой станции 
До выбора места размещения базовой станции следует четко определить 
цели осуществления проекта и область применения данных, 
вырабатываемых этой станцией. После определения круга решаемых 
задач рекогносцировка позволяет определить состав необходимой 
аппаратуры и программного обеспечения и уточнить дополнительные 
требования. 
Указания по выбору места размещения базовой станции приведены на 
интернет-сайте организации UNAVCO (http://facility.unavco.org/). 

Анализ решаемых задач 
До определения места и варианта установки приемника следует 
определить круг решаемых задач. Они оказывают влияние практически на 
все аспекты планирования и выполнения проекта, в том числе на 
рекогносцировку места, выбор аппаратного и программного обеспечения и 
объем анализируемых для этого факторов. В частности, следует дать 
ответы на следующие вопросы: 

• Кто именно будет конечным потребителем и предполагаемое 
количество пользователем (количество абонентов, имеющих доступ 
к данным, количество операторов, анализирующих данные и т.д.). 

• Какие каналы связи будут использоваться. 

• Необходимый состав измерительной информации и формат ее 
представления. 

• Место размещения приемника (зависит от потенциально 
подходящих пунктов и целей развертывания системы). 

• Способ использования приемника: в качестве изолированной 
станции или как часть сети. 

• Планируемый срок эксплуатации (краткосрочный проект или 
постоянно функционирующая станция). 

Все лица, осуществляющие проект, должны иметь четкое представление о 
предметной области, решаемых задачах и целях осуществления проекта. 
После уточнения решаемых задач можно приступить к предварительному 
отбору мест размещения станции, и уже из этих альтернатив остановить 
свой выбор на наиболее подходящей позиции. 
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Рекогносцировка места 
размещения станции 
При определении места, где будет находиться NET-G3, следует 
руководствоваться безопасностью персонала и сохранностью приемника. 
При монтаже оборудования и обслуживании необходимо придерживаться 
следующих правил: 

• Расположение антенны и приемника 
Антенну следует расположить в месте с чистым небосводом, 
поблизости не должны располагаться радиоотражающие объекты. 
Приемник следует разместить в помещении и поставить на 
плоскую поверхность (стол или хорошо закрепленную полку),  
обеспечив свободный доступ к передней и задней панелям 
прибора. 

• Сетевое оборудование и антенный кабель 
Помещение следует оборудовать кабель-каналами, 
препятствующими повреждению кабелей по неосторожности, но не 
мешающими проведению регламентных работ. 
Для обеспечения правильного подключения оборудования и его 
надежной работы следует использовать только специальные 
кабели, произведенные TPS. Придерживайтесь следующих 
рекомендаций при подключении: 

- Каждый кабель следует маркировать ярлыком на обоих 
концах. 

- Не следует превышать стандартную длину кабеля,  
т.е. применять кабель длиннее, чем предписывается 
соответствующими стандартами и ТУ. 

- Освобождайте все кабельные разъемы от пыли и прочих 
загрязнений. 

- Если Вы используете кабель собственного изготовления, 
проверьте качество его изготовления (обжимки, опайки 
разъемов). 

- Убедитесь в том, что вы подсоединили все кабели к  
соответствующим им разъемам. Проверьте надежность 
подключения. 

Прокладка антенного кабеля является одним из основных 
факторов, влияющих на успешное функционирование базовой 
станции, особенно если длина кабеля превышает 30 метров, или к 
одному приемнику подключаются несколько антенн. Правила 
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прокладки антенного кабеля описаны в разделе "Прокладка 
фидерной системы" на странице 3-15. 

• Доступность электропитания 
К помещению, предназначенному для размещения опорной 
станции, должна быть подведена сеть электропитания, 
соответствующая требованиям приемника и всего установленного 
оборудования. Приемник должен быть подключен к заземленной 
розетке. 
В NET-G3 предусмотрена возможность подключения двух 
независимых источников питания и автоматического переключения 
между ними без перерывов в работе. 

- Порт PWR 1 можно подключить к сети переменного тока с 
помощью сетевого адаптера, входящего в комплект. 

- Порт PWR 2 может быть подключен к любому резервному 
источнику постоянного тока (в т.ч. источнику бесперебойного 
питания, ИБП) с выходным напряжением в пределах от 6 до 28 
Вольт. 

При пропадании напряжения на PWR 1 приемник автоматически 
переключается на порт PWR 2. Когда питание на PWR 1 
восстанавливается, приемник автоматически переходит на 
использование этого порта без перерывов в работе. 

• Кондиционирование 
Приемник NET-G3 спроектирован для работы в неблагоприятных 
условиях окружающей среды и может использоваться без принятия 
специальных мер ограниченное время. Помещение для 
долговременной эксплуатации следует оборудовать 
кондиционером. 

• Молниезащита и броски напряжения 
Для защиты от бросков напряжения в электрической сети, 
необходима установка газоразрядников, фильтров по питанию и 
т.п. Для получения более подробных консультаций, обратитесь к 
сертифицированному инженеру-электротехнику. 
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Установка программ Topcon 
CD диск Topcon GPS+ включает следующие программы, используемые 
для настройки и управления приемником. Эти программы также доступны 
для зарегистрированных пользователей на сайте TPS. 

• PC-CDU Lite, версия 2.1.16 или более новая. 

• Topcon Link, версия 6.04 или более новая. 

• FLoader, версия 1.0.07 или более новая. 
Для установки программ с CD диска GPS+ вставьте его в CD-ROM привод 
компьютера. При загрузке программ с Интернет сайта извлеките файлы 
программ в папку на жестком диске Вашего компьютера. Описание 
программы Topcon Link подробно описывает ее установку и работу с ней. 
Если Вы приобрели TopNET (пакет специализированного ПО для 
обслуживания базовой станции), в его описании Вы найдете подробные 
инструкции по установке ПО и настройке приемника NET-G3 для работы с 
ним. 

Установка программы PC-CDU 
PC-CDU™ - это программный продукт, работающий под управлением ОС 
Windows®, разработанный для управления приемниками производства 
фирмы Topcon. PC-CDU использует специализированный язык 
интерфейса приемника GPS (GRIL) для настойки разнообразных 
параметров приемника и контроля за его функционированием. 
Программа PC-CDU существует в двух версиях: полной - PC-CDU MS, и 
упрощенной - PC-CDU Lite. PC-CDU Lite доступна бесплатно на Интернет -  
сайте Topcon и CD диске GPS+. 
Минимальные системные требования: Windows®98 или более новая, RS-
232C или USB порт, либо Bluetooth. Для правильной настройки приемника 
используйте версию PC-CDU 2.1.15 или более новую. 

Обратитесь к справочному руководству PC-CDU для 
полной информации об установке и использовании 
PC-CDU. 

1. Создайте папку PC-CDU на жестком диске и скопируйте в нее файл 
zip архива PC-CDU (полученный с Интернет сайта или CD диска 
GPS+). 
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2. Перейдите в папку PC-CDU и дважды щелкните по файлу PC-
CDU.Zip. 

3. Извлеките PCCDU.EXE и присоединенный файл *.dll в папку PC-
CDU (см. рисунок 2-1). 

4. Создайте ярлык на рабочем столе вашего компьютера для быстрого 
доступа к PC-CDU (см. рисунок 2-1). 

 
Рисунок 2-1. Извлеките программу и создайте ярлык 

Для удаления PC-CDU откройте папку, содержащую файл *.exe. Выберите 
этот файл и нажмите кнопку Del клавиатуры. 

Установка программы FLoader 
FLoader – утилита для перепрограммирования встроенного ПО платы 
питания, модуля GPS и платы радиомодема, размещенных внутри 
приемника. FLoader поставляется на CD диске GPS+. 
Минимальные системные требования: Windows®98 или более новая, RS-
232C или USB порт, либо Bluetooth. Для правильной настройки приемника 
используйте версию FLoader 1.0.07 или более новую. 

1. Создайте папку FLoader на жестком диске и скопируйте в нее файл 
zip архива FLoader, полученный с Интернет сайта или CD диска 
GPS+. 

2. Откройте папку FLoader и дважды щелкните по файлу FLoader.Zip. 
3. Извлеките файл FLoader.exe в папку FLoader (см. рисунок 2-5). 
4. Создайте ярлык на рабочем столе вашего компьютера для быстрого 

доступа к FLoader (см. рисунок 2-5). 
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Рисунок 2-2. Извлечение программы и создание ярлыка 

Для удаления FLoader откройте папку, содержащую файл с расширением 
exe. Выберите этот файл и нажмите клавишу Delete. 

Установка CF карты 
Под крышкой на передней панели находится разъем для карты памяти 
формата CF, на которую производится запись данных измерений. В 
комплект NET-G3 входит CF карта объемом 512 Мб или опциональная 
объемом 1 Гб. Карта памяти также может быть приобретена в 
компьютерном магазине. 
CF карта должна быть установлена до включения приемника. Крышка 
позволяет также получить простой доступ к разъему для извлечении 
карты. 

 

Для обеспечения целостности данных, установку и 
извлечение CF карты следует производить в 
выключенный приемник. 

1. Удостоверьтесь в том, что приемник выключен. 
2. Вывинтите два винта крышки. 
3. Аккуратно вставьте CF карту в разъем ярлыком вверх (см. рисунок 2-

3 на странице 2-8). 
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Вставьте карту CF

Кнопка выброса 
карты

 
Рисунок 2-3. Установка CF карты 

Утопите кнопку выброса карточки перед установкой 
крышки. 

После включения приемник опознает CF карту и будет ее использовать. 
Перед извлечением CF карты прежде всего выключите прибор. Откройте 
крышку и нажмите на кнопку выброса карты, находящуюся слева от 
разъема. Карта будет вытолкнута из гнезда. 

Питание приемника 
Для питания NET-G3 используются внешние источники питания (см. 
рисунок 2-4 на странице 2-9). При установке приемника примите во 
внимание следующее: 

• Никогда не используйте удлинители – это чревато возгоранием. 

• Всегда подключайтесь к заземленным розеткам. 

• Для защиты электронных устройств используйте предохранители. 
NET-G3 оснащен двумя портами питания, и для работы может 
использоваться любой из них. 

1. Подключите кабель к адаптеру питания. 
2. Сочлените SAE разъемами кабель питания и адаптер питания. 
3. Подключите кабель питания к порту PWR на задней панели 

приемника. 
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4. Подключите кабель питания к розетке. 

Подключите к 
заземленной
розетке

 
Рисунок 2-4. Подключение NET-G3 к источнику питания 

Контроль состояния питания 
Состояние электропитания приемника можно проконтролировать при 
помощи индикаторов PWR или программного обеспечения Topcon. 
Состояние питания индикатор отображает следующим образом: 

• Непрерывно светится зеленым цветом – приемник использует 
питание по этому порту и напряжение находится в рабочем 
диапазоне от 6 до 28 Вольт постоянного тока. 

• Непрерывно светится желтым цветом – по этому порту к приемнику 
поступает напряжение в рабочем диапазоне от 6 до 28 Вольт 
постоянного тока, но данный порт для питания не используется. 

• Непрерывно светится красным цветом – напряжение на этот порт 
питания не подается. Подробное описание см. в разделе “Отказы 
системы питания” на странице 5-3. 

Для контроля состояния питания приемника с помощью программного 
обеспечения изучите описание этой программы. 
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Включение/выключение приемника 
Для включения приемника нажмите и удерживайте кнопку питания до 
кратковременной вспышки светодиодов. 
Для выключения приемника нажмите и удерживайте кнопку питания более 
одной и менее четырех секунд (до тех пор, пока не погаснут светодиоды 
STAT и REC). Упомянутая выше односекундная задержка препятствует 
случайному выключению приемника. 

Сбор альманахов и эфемерид 
Каждый спутник передает навигационное сообщение, которое содержит 
эфемериды спутника, альманах и другую информацию. Эфемериды 
описывают положение спутника как функцию времени. По данным 
альманаха можно рассчитать грубое положение спутника, передавшего 
информацию, и всех спутников этой же системы. 

• Спутники систем GPS и ГЛОНАСС передают эфемериды 
циклически, с периодом 30 секунд. 

• Спутники системы GPS передают информацию альманаха 
циклически с периодом 12,5 минут; спутники системы ГЛОНАСС 
передают информацию альманаха циклически с периодом 2,5 
минуты. 

Если приемник обладает альманахом, то время, необходимое для поиска 
и захвата сигнала спутника, существенно уменьшается. 
Приемник регулярно обновляет альманах и эфемериды, сохраняя самые 
новые данные в своей энергонезависимой памяти (NVRAM). 
1. Установите приемник (соедините с внешней антенной, если это 

необходимо) в месте хорошего обзора небосвода. 
2. Включите приемник. 
3. Подождите примерно 15 минут, пока спутник собирает данные 

альманаха от спутников. 

Если 15 минут прошло, а приемник не захватил 
спутниковые сигналы, очистите энергонезависимую 
память (NVRAM). Эта процедура описана в разделе 
"Очистка энергонезависимой памяти (NVRAM) " на 
странице 4-12. 

Следует собрать или обновить альманах и эфемериды в следующих 
случаях: 
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• Если приемник был выключен в течение продолжительного 
периода времени. 

• Если последнее определенное приемником местоположение 
(сохраненное в энергонезависимой памяти), отличается от 
текущего местоположения на несколько сотен километров. 

• После загрузки нового OAF. 

• После загрузки нового программного обеспечения. 

• После очистки энергонезависимой памяти (NVRAM). 

Подключение приемника к 
компьютеру 
Настройка приемника, отсылка на него служебных команд и копирование 
файлов измерений из его памяти возможны только после установления 
соединения между приемником и компьютером. После подключения 
кабеля следует установить соединение соответствующей программы (PC-
CDU, TopNET и т.п.). И PC-CDU, и TopNET обеспечивают возможность 
настройки, контроля состояния и управления приемником. Другое ПО, 
например Floader, предназначено для обновления, обслуживания и 
настройки отдельных узлов подключенного приемника. 

Соединение с приемником можно установить по перечисленным ниже 
интерфейсам: 

• Кабель RS232. 

• USB кабель (на компьютер следует предварительно установить 
драйвер TPS USB). 

• Ethernet кабель (компьютер должен быть оснащен сетевой картой, 
стек TCP/IP следует настроить заранее). 
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Установление соединения через 
RS232 
Ниже описывается подключение приемника к компьютеру с помощью 
кабеля RS-232. В разделе "Установление соединения в программе PC-
CDU" на странице 2-17 описывается подключение программы к приемнику. 

1. Используя кабель, подключите последовательный порт Вашего 
компьютера (обычно, COM1) с одним из последовательных портов 
приемника (или ODU или DB-9). 

2. Включите приемник и компьютер, нажав на их кнопки питания.  

Установление соединения через 
USB 
Удостоверьтесь в том, что драйвер TPS USB установлен на компьютер. 
Ниже описывается подключение приемника к компьютеру с помощью 
кабеля USB. В разделе "Параметры подключения PC-CDU" на странице 2-
17 описывается подключение программы к приемнику. 
1. Соедините USB порт Вашего компьютера с USB портом приемника 

кабелем USB. 
2. Включите приемник и компьютер, нажав на их кнопки питания. 

Последовательные 
порты

Порт USB

 

Рисунок 2-5. Последовательные и USB порты NET-G3 
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Установление соединения через 
Ethernet 
До подключения с использованием Ethernet удостоверьтесь в том, что 
произведена настройка TCP/IP стеков приемника и компьютера. Для этого 
требуется предварительное подключение по RS232. Подробнее см. 
раздел "Настройка Ethernet соединения в PC-CDU" на странице 2-14. 
NET-G3 и соответствующее ПО поддерживает два варианта Ethernet 
подключения с использованием Ethernet адаптера, входящего в комплект 
и сетевого кабеля, приобретенного в компьютерном магазине: 

• Прямое подключение производится с применением Ethernet кросс 
патч-корда. 

• Подсоединение к существующей сети TCP/IP производится с 
применением Ethernet патч-корда. 

Ниже описывается подключение приемника к компьютеру с помощью 
кабеля Ethernet. В разделе "Параметры подключения PC-CDU" на 
странице 2-17 описывается подключение программы к приемнику. 

1. Подключите 12-и штырьковый разъем адаптера Ethernet в порт 
ETHR приемника. 

2. Подключите другой конец адаптера к прямому или кросс патч-корду 
Ethernet. 

3. Вставьте второй конец патч-корда в соответствующий разъем 
компьютера или сетевого коммутатора. 

Кросс патч-корд,
подключить к 
компьютеру напрямую

Прямой патч-корд,
подключить к сетевому
коммутатору

 
Рисунок 2-6. Подключение кабеля Ethernet 
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Настройка Ethernet соединения в 
PC-CDU 
До подключения приемника NET-G3 через интерфейс Ethernet следует 
настроить этот интерфейс. Для использования подключения через 
Ethernet нужно использовать перечисленное ниже программное 
обеспечение и оборудование: 

• Компьютер с Ethernet картой и настроенным TCP/IP стеком. 

• Программа PC-CDU самой последней версии. 

• Приемник NET-G3 с разрешенными к эксплуатации опциями Ethernet 
и FTP. Подробное описание опций приемника приводится в разделе 
"Управление опциями приемника" на странице 4-8. 

• Подключение к компьютерной сети требует выделения для каждого 
приемника уникального статического IP адреса (даже в случае 
использования протокола DHCP), знания маски подсети и IP-адреса 
шлюза. 

При подключении приемников TPS к компьютерной 
сети воспользуйтесь помощью системного 
администратора этой сети. 

Приведенный ниже порядок действий описывает порядок подключения к 
компьютеру через порт Ethernet и набор параметров настройки, 
обеспечивающих взаимодействие включенных в сеть устройств с 
приемником. Для примера используется следующие параметры сетевого 
интерфейса приемника: 

• IP адрес – 192.168.0.1 

• Шлюз – 192.168.0.3 (для прямого подключения: если два устройства 
подключаются напрямую и не имеют подключения к другим сетям, 
можно установить адрес шлюза 0.0.0.0) 

• Маска подсети – 255.255.255.0 
Описанные ниже действия производятся как при прямом соединении двух 
устройств, так и при подключении к сети. 
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До подключения к сети попробуйте установить 
прямое соединение этим способом. 

1. Подключите приемник к компьютеру кабелем RS232. См. раздел 
"Установление соединения через RS232" на странице 2-12. 

2. Запустите программу PC-CDU, установите перечисленные ниже 
параметры соединения, после чего щелкните на кнопке Connect 
(Соединить). 

• Connection Mode – Direct (Соединение - Прямое). 

• Port (Порт) – выберите последовательный порт компьютера, к 
которому подключен приемник. 

• Baud rate (Скорость обмена) данными между компьютером и 
приемником (обычное значение - 115200). 

3. Выберите пункт меню Configuration > Receiver > Ports >Ethernet 
(Настройка > Приемник > Порты > Ethernet). 

4. Установите следующие настройки IP приемника в области IP settings 
(см. рисунок 2-7 на странице 2-16): 

• IP Address (Адрес IP) – при подключении к сети запросите 
значение этого параметра у системного администратора, для 
прямого соединения прибавьте 1 к IP адресу компьютера. 

• IP Mask (Маска подсети) – введите значение, использованное 
в TCP/IP стеке компьютера. 

• Gateway (IP адрес шлюза) – введите значение, 
использованное в стеке компьютера. 

5. В области настроек Telnet оставьте значения всех параметров 
заданными по умолчанию (исходными) и убедитесь в том, что 
значение TCP порта установлено как 8002 (см. рисунок 2-7 на 
странице 2-16). 

• TCP port (Используемый порт)  – 8002 (исходное значение). 
Порт, по которому приемник ожидает telnet соединения. 
Приемник поддерживает до пяти одновременных telnet 
соединений. 

• Timeout (Временное ограничение) – 600 (исходное значение). 
Этот параметр устанавливает продолжительность временного 
интервала, в течение которого неиспользуемое соединение 
продолжает оставаться открытым. По истечении указанного 
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времени приемник автоматически закрывает неиспользуемое 
соединение. 

6. Введите значения параметров в области FTP settings (Параметры 
протокола передачи файлов) (см. рисунок 2-7): 
• TCP port (Используемый порт) – 21 (исходное значение). Это 

номер порта (в терминологии IP), по которому приемник 
поддерживает пассивное FTP соединение. Приемник 
поддерживает только одно FTP соединение. 

• Timeout (Временное ограничение) – 600 (исходное значение). 
Этот параметр устанавливает продолжительность временного 
интервала, в течение которого неиспользуемое соединение 
продолжает оставаться открытым. По истечении указанного 
времени приемник автоматически закрывает неиспользуемое 
соединение. 

7. При необходимости ограничения доступа к FTP серверу задайте 
Network Password (Сетевой пароль) (см. рисунок 2-7). 

 
Рисунок 2-7. Настройки Ethernet соединения на примере FTP сети 

8. Для пересылки параметров в приемник щелкните на кнопке Apply 
(Применить), затем на кнопке OK. 

9. Выберите пункт меню Tools > Reset receiver (Инструменты > 
Перезагрузка приемника). 

10. Выберите пункт меню File > Disconnect (Файл > Отсоединить). 
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11. Подключите приемник к компьютеру или сетевому устройству в 
соответствии с указаниями раздела “Установление соединения 
через Ethernet” на странице 2-13. 

Параметры подключения PC-CDU 
При подключении приемника к PC-CDU, тип соединения определяет 
выбираемые параметры. В таблицах 2-1 и 2-2 приводятся параметры для 
четырех типов подключений. 

Табл. 2-1. Параметры подключения PC-CDU для RS232 и USB 

Параметр RS232 USB 

Тип подключения Прямое (Direct) 
Port (Порт) Порт компьютера, к 

которому подключен 
приемник (для RS232 
обычно COM1 или COM2) 

USB 

Baud Rate (Скорость) Скорость соединения 
(обычно, 115200) Не применяется 

Rec ID Не применяется Идентификационный 
номер приемника 

 

 
Рисунок 2-8. Настройки подключения PC-CDU – интерфейсы RS232 и USB 
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Табл. 2-1. Параметры подключения PC-CDU для Ethernet 
 
Параметр Direct (Прямое) Network (Сетевое) 

Тип подключения Прямое (Direct) 

Port (Порт) ETHR 

TCP Port 8002 (исходное значение) 

Host name IP адрес узла сети 

Password (Пароль) Не применяется Устанавливается при 
настройке 

 

 
Рисунок 2-9. Настройки подключения PC-CDU – Ethernet (на примере прямого 

подключения) 
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Управление питанием 
Программное обеспечение PC-CDU позволяет производить настройки 
рабочих параметров приемника, следить за его состоянием и управлять 
им. Topcon PC-CDU отображает текущее напряжение источника питания.  
1. Подключите приемник к компьютеру согласно указаниям раздела 

"Подключение приемника к персональному компьютеру” на странице 2-
10. 

2. После установления соединения выберите пункт меню Configuration > 
Receiver (Установка > Приемник). 

3. В поле On Board области Voltages (Напряжения) (см. рисунок 2-10) 
отображается значение напряжения, подводимого к плате приемника.  

 
Рисунок 2-10. Просмотр текущего значения напряжения 
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Для заметок: 
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Глава 3  
Настройка и 
подготовка к съемке 
NET-G3 предназначен, прежде всего, для работы на стационарных или 
временных опорных станциях ГНСС и поддержки приложений реального 
времени и приложений с камеральный обработкой. Данные измерений 
могут быть переданы через любой порт приемника на произвольное 
устройство, способного к их приему и обработке (в частности, 
программному обеспечению TopNET). Данные измерений могут также 
накапливаться на встроенную карту памяти формата CF и после этого 
использоваться для обработки данных статической или кинематической 
съемки, картографирования, мониторинга и прочих видов 
местоопределения. 
NET-G3 можно настроить для многих применений, в том числе: 

• Как постоянно функционирующую опорную станцию. 

• Как временную опорную станцию. 

• В качестве подвижного приемника RTK или DGPS (для слежения за 
стабильностью зданий и сооружений, слежения за состоянием 
спутниковой навигационной системы или в качестве полевого 
съемочного приемника) 

В этом разделе приводится данные о основных параметрах настройки 
NET-G3 для некоторых из этих областей применения. Более подробная 
информация содержится в документации на программы PC-CDU и 
TopNET. 
Независимо от области решаемых задач или программного обеспечения, 
используемого для настройки, основные этапы настройки NET-G3 
следующие: 

"Настройка приемника” на странице 3-2. 

“Настройка пользовательского интерфейса MINTER” на странице 3-8. 

“Установка временной опорной станции” на странице 3-16. 

“Определение координат опорной станции статической съемкой” на 
странице 3-20. 
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Настройка приемника  
NET-G3 чаще всего используется в качестве неподвижной опорной 
станции, которая производит ГНСС измерения, сохраняет их на съемной 
карте памяти формата CF, передает данные на центральный компьютер 
сети опорных станций и, возможно, подключена напрямую к одному или 
большему количеству радиомодемов (возможны произвольные 
комбинации перечисленных функций). Программы PC-CDU и TopNET 
позволяют настроить различные узлы приемника, при этом установки 
будут сохраняться в его энергонезависимой памяти. Настраивается, в том 
числе, и MINTER (пользовательский интерфейс передней панели).  
Полное описание всех возможностей PC-CDU и TopNET приводится в 
соответствующих руководствах пользователя. Дополнительные указания 
по любой из описанных в этом разделе процедур см. там же. 
После того, как соединение между приемником и компьютером 
установлено, можно произвести: 

• Настройку приемника и его узлов. 

• Передачу команд приемнику. 

• Копирование файлов данных из памяти приемника. 

• Загрузку в приемник нового файла OAF и других файлов настроек. 
Ниже приводится пример настройки NET-G3 в качестве опорной станции, 
записывающей данные в память и использующей радиомодем для 
передачи дифференциальных поправок. Для настройки используется 
программа PC-CDU. 

 

Любое изменение следует производить после 
тщательного изучения описания соответствующего 
параметра в “Руководстве пользователя PC-CDU”. 

1. Подключите приемник к компьютеру одним из способов, описанных в 
разделе "Подключение приемника к компьютеру" на странице 2-11. 

2. Запустите программу PC-CDU и установите соединение согласно 
указаниям раздела "Параметры подключения PC-CDU" на странице 2-
17. 
После того, как программа PC-CDU установила соединение с 
приемником, текущие параметры соединения (название порта, скорость 
передачи данных (если применима для этого типа порта), способ 
квитирования) отображаются в левом нижнем углу основного окна 
программы. В правом нижнем углу находится счетчик времени 
выполнения программы (см. рисунок 3-1). 
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Рисунок 3-1. Подключение к PC-CDU 

3. Выберите пункт меню Configuration > Receiver (Настройка > 
Приемник). 

Следует использовать кнопку Apply (Применить) 
после любого изменения параметров, в противном 
случае новые значения параметров в приемник не 
передаются.  

4. Щелкните на кнопке Set all parameters to defaults (Принять начальные 
значения для всех параметров), см. рисунок 3-2. 

 
Рисунок 3-2. Принять начальные значения для всех параметров 

5. Выберите вкладку MINTER и произведите установку параметров, 
перечисленных в таблице 3-1, после чего щелкните на кнопке Apply 
(Применить), см. рисунок 3-3. 
Таблица 3-1. Параметры приемника, устанавливаемые во вкладке MINTER. 
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Параметр Значение 

Recording interval 
(Период записи) Введите значение 15 секунд. 

Elevation Mask Angle 
(Минимальный угол 
места) 

Введите значение 15 градусов. 

File name prefix 
(Префикс названия 
файла) 

Введите три последние цифры серийного номера 
приемника. 

(начало/окончание записи данных по нажатию клавиши 
FN) 

FN key mode (режим 
клавиши FN) Для записи в статическом режиме выберите значение 

LED blink mode switch (Переключатель режима 
светодиода) 

 

 
Рисунок 3-3. Настройка приемника для записи в статическом режиме - вкладка 

MINTER 
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6. Выберите вкладку Positioning (Местоопределение) и установите 
значение поля Elevation Mask (Минимальный угол места) – 15 градусов 
(см. рисунок 3-4), после чего щелкните на кнопке Apply (Применить). 

 
Рисунок 3-4. Установка минимального угла места 

7. Выберите вкладку Base (Базовый) и произведите установку 
перечисленных ниже параметров (см. рисунок 3-12 на странице 3-16), 
после чего щелкните на кнопке Apply (Применить). 
• Установите флаг GPS/GLO at one time (GPS и ГЛОНАСС 

одновременно). 
• Введите координаты антенны, Lat - широту, Lon – долготу и Alt – 

высоту одним из следующих способов: 
- Если они известны заранее, введите соответствующие 

значения. 
- Установите флажок Averaged (Осредненные) и введите 

значение Averaged Span (Интервал Осреднения), выраженный 
в секундах, после чего щелкните на кнопке Apply (Применить). 
Выберите пункт меню Tools > Reset receiver (Инструменты > 
Перезапуск приемника) и подождите, пока не пройдет 
заданный интервал времени. После этого координаты станции 
на вкладке Base должны соответствовать координатам, 
полученным после осреднения. Если координаты 
отображаются как нулевые, щелкните на кнопке Refresh 
(Обновить). 

- Щелкните на кнопке Get from receiver (Получить из 
приемника). 

Координаты антенны, задаваемые на этой вкладке, 
относятся к фазовому центру антенны в 
поддиапазоне L1. 

Для RTK съемок продолжите с шага 8 на странице 3-6, а для 
остальных приложений – с шага 9 на странице 3-7. 
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Рисунок 3-5. Настройка базовой станции 

8. Для RTK съемок выберите вкладку Ports (Порты) и установите 
параметры последовательного порта (см. Табл. 3-2), после чего 
щелкните на кнопке Apply (Применить), рисунок 3-14 на странице 3-18. 

Для съемок с камеральной обработкой оставьте 
значения этих параметров заданными по умолчанию.

Таблица 3-5. Параметры приемника, устанавливаемые во вкладке Ports. 

Параметр Базовый приемник 

Input (Вход) Не применимо (оставьте исходное значение, Command). 

Output (Выход) Выберите формат и типы дифференциальных поправок 

Period (sec) 
(Период выдачи 
поправок [c]) 

Задайте период выдачи дифференциальных поправок. 

Baud Rate Скорость 
передачи) 

Выберите скорость последовательного порта, по 
которому плата приемника выдает дифференциальные 
поправки на плату модема. 
Скорость следует установить равной скорости 
последовательного порта модема. 

RTS/CTS Выставьте флажок для разрешения аппаратного 
квитирования.  
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Рисунок 3-6. Настройка базовой станции RTK – порты 

9. Выберите вкладку Advanced (Расширенные функции), затем вкладку 
Multipath Reduction (Подавление многолучевости), выставьте 
перечисленные ниже флажки и щелкните на кнопке Apply (Применить) 
(см. рисунок 3-7). 
• Code multipath reduction (подавление многолучевости в измерении 

по коду). 
• Carrier multipath reduction (подавление многолучевости в 

измерении по фазе несущей). 

 
Рисунок 3-7. Настройка параметров подавления многолучевости 

10. Щелкните на кнопке OK для сохранения изменений и закройте окно. 
После настройки приемника настройки сохраняются до тех пор, пока вы 
не измените их с помощью PC-CDU или очистите NVRAM. 
Для получения подробной информации о доступных настройках для 
Базовых и Удаленных приемников, обратитесь к справочному 
руководству PC-CDU. 
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11. Продолжите выполнение других действий настройки или щелкните 
File > Disconnect (Файл > Отсоединить), а затем File > Exit (Файл > 
Выход), чтобы закончить работу PC-CDU. Разъединение перед 
выходом гарантирует надлежащее управление портом. 

Перед окончанием работы программы следует 
разорвать соединение между приемником и PC-CDU. 
Это поможет избежать конфликтов в управлении 
последовательными портами компьютера. 

Настройка пользовательского 
интерфейса MINTER 
MINTER (Minimum INTERface - минимальный интерфейс) состоит из двух 
кнопок (Питание и FN (Функция)) и четырех светодиодов (STAT, REC, 
BATT и RX), отображающих состояние приемника и двух светодиодов, 
отображающих состояние портов питания (см. рисунок 3-8). 

 
Рисунок 3-8. MINTER 

С помощью MINTER можно осуществить перечисленные ниже действия 
(подробнее см. раздел “Использование MINTER” на странице 3-21): 

• Включение и выключение приемника, перевод его в режим низкого 
энергопотребления (Sleep mode). 

• Включение и выключение записи данных (кнопка FN)
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• Изменение режима отображения. 
• Отображение светодиодом STAT числа отслеживаемых спутников 

GPS (зеленый цвет) и ГЛОНАСС (оранжевый). 

• Отображение состояния записи данных (светодиод REC). 

• Индикация цикла записи данных (светодиод REC). 

• Индикация состава записываемых данных (статический или 
динамический) при выполнении кинематической съемки для 
постобработки (производится через кнопку FN и светодиод REC). 

• Индикация состояния питания приемника (светодиоды PWR). 
Для настройки параметров MINTER используйте программу PC-CDU. 
Полное описание всех возможностей PC-CDU приводится в “Руководстве 
пользователя PC-CDU”. 
1. Подключите приемник к компьютеру. Эта процедура описана в разделе 

“Подключение приемника к компьютеру” на странице 2-11. 
2. В диалоговом окне Connection Parameters (Параметры 

интерфейсов) выставьте флажок RTS/CTS handshaking 
(квитирование сигналами RTS/CTS) (см. рисунок 3-9). 
Описание остальных параметров в этом окне приводится в разделе 
“Параметры подключения PC-CDU“ на странице 2-17. 

3. Щелкните на кнопке Connect (Соединить). 

 
Рисунок 3-9. Диалоговое окно Connection Parameters (Параметры интерфейсов) 
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4. Выберите пункт меню Configuration > Receiver (Настройка > 
Приемник), затем вкладку MINTER, установите перечисленные ниже 
значения параметров настроек и щелкните на кнопке Apply (см. рисунок 
3-18). Описание этих параметров приводится на указанных страницах: 
• Recording interval (Интервал записи) – страница 3-10. 
• Elevation mask for log file (Минимальный угол места для записи 

данных) - страница 3-22. 
• File name prefix (Префикс имени файла) – страница 3-22. 
• Always append to the file (Всегда добавлять к файлу) – страница 

3-23. 
• Files creation mode (Режим создания файлов) – страница 3-23. 
• Automatic File Rotation Mode (AFRM) (Режим автоматического 

создания файлов) – страница 3-23. 
• FN key mode (Функция кнопки FN) - страница 3-24. 
• Initial data collection dynamic mode (Исходная динамическая 

модель при сборе данных) - страница 3-25. 
• Data recording auto-start (Восстановление записи данных) – 

страница 3-25. 

 
Рисунок 3-10. Вкладка MINTER диалогового окна Connection Parameters 

(Параметры интерфейсов) 

Параметр Recording interval (Интервал записи). 
Устанавливает интервал записи блоков измерений в файл измерений. 
Файл измерений создается после нажатия кнопки FN 
(продолжительность нажатия от 1 до 5 секунд). Этот параметр 
используется как при сохранении единственного файла, так и в 
режиме AFRM (Режим автоматического создания файлов). Диапазон 
допустимых значений – от 1 до 86400 сек. Начальное значение этого 
параметра - 1 секунда. 
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Параметр Elevation mask for log file (Минимальный угол места для 
записи данных). 

Устанавливает минимальный угол возвышения для спутников, данные 
измерений для которых записываются в файл, создаваемый после 
нажатия кнопки FN. Начальное значение - пять градусов. 

Параметр File name prefix (Префикс имени файла). 
Устанавливает начало названия файлов измерений, создаваемых 
приемником после нажатия кнопки FN. Длина префикса может 
достигать 20 символов. Начальная установка для префикса - “log” 
(“архив”). 
Название файла измерений образуется следующим образом: 
<префикс><месяц><день><очередная буква алфавита> 
Название файлов формируется из времени создания (месяц и день) 
файла и дополнительных буквенных суффиксов, которые позволяют 
различить файлы, созданные в один день. 

Параметр Always append to the file (Всегда добавлять к файлу). 
Если Вы хотите, чтобы измерения добавлялись в один файл (новые 
файлы создаваться не будут), задайте название такого файла в этом 
параметре. Допустимая длина названия - до 20 символов. 

Параметр Files creation mode (Режим создания файлов). 
Этот параметр задает один из двух возможных рабочих режимов: 

• Log file (файл измерений) - если выбран этот режим, то нажатие на 
кнопку FN закрывает открытый в настоящий момент файл измерений. 
Если файл измерений не был открыт, то нажатие кнопки FN 
открывает новый файл измерений. 

• AFRM - если выбран этот режим, то нажатие на кнопку FN включает 
его. Если режим AFRM уже действует, нажатие кнопки FN отключает 
его. 

Параметры Automatic File Rotation Mode (AFRM) (Режим 
автоматического создания файлов).  

В приемниках TPS предусмотрен режим автоматического создания 
файлов. В этом режиме по определенному пользователем 
расписанию приемник закрывает текущий и открывает новый файл 
измерений. Расписание определяется параметрами Period(Период) и 
Phase(Фаза). Переход на новый файл производится  в тот момент, 
когда остаток от деления текущего времени приемника на Period 
равен Phase. Переключение текущего файла измерений производится 
таким образом, что момент относимости первого блока измерений в 
файле соответствует моменту времени, задаваемому в расписании. 
После того, как очередной файл измерений будет открыт, приемник 
сохраняет в этом файле набор типов записей с определенным 
периодом. Набор и период задаются пользователем. 

• Period (Период) - в этом поле указывается продолжительность записи 
каждого из файлов в режиме AFRM. 
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Допустимые значения периода – от 60 до 86400 секунд; начальная 
установка – 3600 сек. 

• Phase (Фаза) - устанавливает “фазу” (временной сдвиг внутри 
периода) для создания файла в режиме AFRM. 
Допустимые значения фазы – от 0 до 86400 сек; начальная установка 
– 0 сек. 

• Files(total) (Файлов, всего) - параметр, устанавливающий предельное 
количество файлов измерений, создаваемых в режиме AFRM (при 
достижении этого предела режим AFRM отключится). 
Обратите внимание на то, что первый файл измерений создается 
сразу после включения режима AFRM. Этот файл не рассматривается 
как очередной файл и не увеличивает счетчик, предельное значение 
которого определяется этим параметром. 
Допустимые значения находятся в диапазоне от 0 до (231 –1); 
начальная установка – 0. Значение параметра, равное 0, 
устанавливает отмену ограничения на количество записываемых в 
режиме AFRM файлов.  

Максимальное количество файлов во встроенной 
памяти приемника – 1024. 

• Files(remain) (Файлов, осталось) – поле отображает количество 
файлов, которое еще можно создать в режиме ARFM. 
Допустимые значения находятся в диапазоне от 0 до (231 –1); 
начальная установка – 0. 

• Automatically remove old files (автоматическое удаление устаревших 
файлов) - этот параметр анализируется, если при записи данных 
свободное пространство во встроенной памяти закончилось. Если 
флажок установлен, то в такой ситуации приемник сотрет наиболее 
ранний файл. Затирание устаревших файлов работает только в 
режиме ARFM. 
Начальная установка – не использовать. 

Параметр FN key mode (Функция кнопки FN). 
Этот параметр определяет поведение приемника при нажатии кнопки 
FN. 
• LED blink mode switch (Переключатель режима светодиода) –

нажатие клавиши FN осуществляет выбор между режимами 
нормального или расширенного отображения и начинает или 
останавливает запись данных статической съемки. 
− кнопка FN, нажатая менее чем 1 секунду: выбор между 

режимами нормального или расширенного отображения. 
− кнопка FN, нажатая от 1 до 5 секунд: запускает или 

останавливает запись данных (режим сбора данных для 
камеральной обработки статической съемки). 



Настройка пользовательского интерфейса MINTER 

P/N 7010-0713 3-13 

• Occupation mode switch (Переключатель режима съемки) - 
нажатие кнопки FN (продолжительностью менее 1 секунды) 
инициирует добавление в файл измерений сообщения о том, что 
тип съемки был изменен со статического на кинематический или 
наоборот. Если светодиод REC вспыхивает зеленым цветом, то 
текущий режим – кинематическая съемка, если оранжевым – 
статическая съемка. Более подробная информация представлена 
в таблице 1-2 на странице 1-14, а также в Руководстве 
пользователя PC-CDU. 

Параметр Initial data collection dynamic mode (Исходная динамическая 
модель при сборе данных). 

В этом поле осуществляется выбор сообщения с признаком типа 
съемки, которое записывается в начало файла измерений. При 
выборе кнопки Static (Статическая) происходит запись сообщения 
STOP, при выборе кнопки Kinematic (Кинематическая) – сообщения 
GO,Trajectory. 

Параметр Data recording auto-start (Восстановление записи данных). 
В этом поле осуществляется выбор способа, которым будет 
продолжена запись файла измерений при восстановлении после сбоя 
напряжения питания. 
В таблице 3-7 приводятся возможные сценарии и результаты при 
восстановлении после сбоя питания приемника. Под термином 
Заданный файл следует понимать название файла, определенное в 
параметре Always append to the file (Всегда добавлять в файл). 
Автоматический файл – файл, название которого создано в режиме 
AFRM. 

Таблица 3-5. Алгоритм, устанавливаемый параметром Data recording autostart 

Результат при выбранном значении параметра Перед сбоем 
питания Off (Выкл.) On (Вкл.) Always (Всегда) 

Измерения 
сохранялись в 
заданном 
файле. 

После 
восстановления 
питания запись 
данных не 
возобновится. 

После 
восстановления 
питания приемник 
возобновит запись 
данных в тот же 
файл. 

После 
восстановления 
питания приемник 
возобновит запись 
данных в тот же 
файл. 

Данные в 
приемнике 
сохранялись в 
автоматическ
ом файле 

После 
восстановления 
питания запись 
данных не 
возобновится. 

После 
восстановления 
питания откроется 
новый файл, и 
данные будут 
записываться в 
него. 

После 
восстановления 
питания откроется 
новый файл, и 
данные будут 
записываться в 
него. 
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Название 
файла задано, 
но приемник 
еще не начал 
запись данных 

После 
восстановления 
питания запись 
данных не 
начнется. 

Заданный файл не 
откроется. После 
восстановления 
питания запись 
данных не 
начнется 

Откроется 
заданный файл, и 
после 
восстановления 
питания начнется 
запись данных  

Файл не 
установлен; 
запись данных 
приемником 
выключена 

После 
восстановления 
питания запись 
данных не 
начнется 

После 
восстановления 
питания запись 
данных не 
начнется 

Откроется 
автоматический 
файл, и после 
восстановления 
питания начнется 
запись данных 

Помимо этого, если выбрано поле Always, приемник автоматически начнет 
запись данных (во вновь созданный или уже существующий файл) в 
следующих трех случаях: 

• После включения приемника с помощью кнопки POWER (питание) 
• После перезапуска приемника с помощью PC-CDU. 
• После выведения приемника из режима пониженного 

энергопотребления. 

 
Рисунок 3-11. Вкладка MINTER 
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Прокладка фидерной системы 
Прокладываемая кабельная система между антенной или антеннами и 
приемником должна обеспечивать минимальное затухание сигнала. 

• Следует применять антенный кабель минимальной длины. Topcon 
предлагает кабели различной длины от 3 до 100 м. 

• Используйте только коаксиальные кабели с низкими потерями. 
Для фидера длиной до 10м рекомендуется использовать кабель типа 
RG-58. Если необходимо изготовить фидер большей длины (до 30м), 
рекомендуем применить кабель типов RG-8 или LMR-400. Для кабеля 
LMR-400 на частоте 1600 МГц затухание сигнала составляет 0.2 – 0.1 
дБ/м. 
При длине фидера более 30 м рекомендуется использовать линейный 
антенный усилитель или кабель с очень низкими потерями.  
Topcon  предлагает использовать при длине от 30 до 60 м кабель типа 
LMR-400, а при длине 100 м - LMR-600. Для кабеля LMR-600 на частоте 
1600 МГц затухание сигнала составляет 0.1 дБ/м. 

• Полное затухание сигнала в фидере на частоте 1.6 ГГц не должно 
превышать величины 10-12 дБ. 

Для установки нескольких приемников, подключенных к одной 
антенне, используйте антенный делитель мощности, при этом один из 
выходов должен пропускать на антенный вход напряжение постоянного 
тока, поступающее по центральному проводнику коаксиального фидера с 
приемника NET-G3. Делитель мощности также должен обеспечивать 
изоляцию не менее 20 дБ по ВЧ сигналу между выходами. Это будет 
уменьшать взаимные помехи между подключенными к нему приемниками. 
При подаче питания на антенну от отдельного источника используйте 
устройства ввода постоянного напряжения смещения в ВЧ фидер (bias 
tee). Такие устройства бывают оснащены двумя ВЧ коаксиальными 
разъемами и разъемом для подключения внешнего источника питания 
постоянного тока. Один из коаксиальных разъемов обычно маркируется 
как RF+DC (ВЧ + постоянный ток), и на нем присутствует напряжение 
питания постоянного тока. Второй коаксиальный разъем маркируется RF 
(ВЧ), и постоянное напряжение, присутствующее на нем, на разъем 
RF+DC не поступает. На третий разъем, маркированный DC (Постоянный 
ток), следует подать напряжение питания.
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Установка временной опорной 
станции 
Для монтажа NET-G3 при размещении постоянно функционирующей 
базовой станции выбирается стационарный пункт, оборудованный 
доступом к сети электропитания и сетям передачи данных. Также 
обеспечивается место для установки антенны, свободное от препятствий 
и интерференции (источников радиопомех, многолучевости и т.п.). 
Положение антенны для такой станции определяется с очень высокой 
точностью. 
При установке приемника на временной станции для обеспечения 
качественных измерений следует предпринять определенные меры. Ниже 
описывается настройка NET-G3 в качестве временной опорной станции. 
До начала сбора данных следует убедиться в том, что приемник накопил 
текущие альманах и эфемеридные данные (подробнее см. раздел “Сбор 
альманахов и эфемерид“ на странице 2-10). 

Шаг 1: Установка приемника 
1. Поместите приемник на надежно закрепленном основании. Достаточно 

использовать прочную полку или стол. 

 

В разделе "Габариты NET-G3" на странице А-2 
приводится чертеж, на котором обозначены 
крепежные отверстия, которые следует использовать 
для постоянного крепления. 

2. Для постоянной установки просверлите четыре отверстия в полке и 
прикрепите приемник винтами. 

3. Подключите кабель питания к заземленной розетке. Подробнее см. 
"Питание приемника" на странице 2-8. 

4. Подключите антенный кабель. Если производится запись данных на 
внешнее устройство, подключите его через подходящий интерфейсный 
кабель. 
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К антенне 
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К порту
питания 1

К заземленной
розетке

К разъему 
подключения
антенны GPS

 
Рисунок 3-12. Монтаж приемника и подключение кабелей 

Шаг 2: Измерение высоты антенны 
Определение превышения антенны над центром пункта чрезвычайно 
важно при использовании спутниковых методов съемки. Даже если 
определению подлежат только плановые координаты, обработка данных 
спутниковой съемки всегда производится с определением полного 
(трехмерного) положения фазового центра приемной антенны.  
Поскольку приемник вычисляет координаты фазового центра антенны, для 
их редукции на центр пункта следует указать следующее: 

• Измеренную высоту антенны над центром пункта. 

• Метод измерения высоты антенны. 

• Модель используемой антенны. 
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Измерять высоту антенны можно двумя способами: 

• Вертикальный – измеряется длина отрезка от центра до базовой 
точки антенны (antenna reference point, ARP) расположенной на 
нижней части антенны на  нижнем основании втулки станового 
винта. 

• Наклонный - измеряется длина отрезка от центра до одной из точек 
относимости наклонной высоты (slant height measure mark, SHMM). 

Точка, координаты которой определяются в процессе съемки с помощью 
ГНСС, называется фазовым центром антенны. Можно провести аналогию 
с триппель-призмой, при измерении расстояний до которой измерение 
производится до точки, расположенной внутри призмы, и пользователь 
должен учесть в обработке измерений постоянную призмы для пересчета 
измеренного расстояния на конструктив призмы. В случае ГНСС антенны 
порядок учета смещения фазового центра зависит от использованного 
способа измерения высоты антенны.  

• Для вертикального измерения (измерение до ARP) смещение просто 
добавляется к измеренной высоте и получается «истинное» 
превышение.  

• Для наклонной высоты (измерение до SHMM) сначала производится 
редукция этого измерения до вертикального (с учетом известного 
радиуса антенны), после чего порядок действий аналогичен 
приведенному выше. 

Смещения вычисляются разными способами из-за несовпадения точек 
ARP и SHMM. 
1. Измерьте высоту антенны над центром (маркой) пункта методом 

наклонного или вертикального измерений (см. рисунок 3-13 на 
странице 3-19). 

2. В полевой журнал занесите название пункта, высоту антенны над 
центром и способ ее измерения, укажите время начала работы. 
Высота антенны и прочие элементы приведения зависят от 
используемого типа антенны. Эти параметры приводится в 
эксплуатационной документации на антенну. 

Величины элементов приведения содержатся в 
руководстве по эксплуатации антенны. 
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Опорная поверхность 
для определения смещений

 
Рисунок 3-13. Пример задания элементов приведения антенны 

Шаг 3. Сбор данных 
Помимо этого раздела данному вопросу посвящены также и все 
оставшиеся разделы этой главы. 
1. Включите приемник. Светодиод STAT должен кратковременно  

вспыхнуть красным цветом. 
• Как только приемник установит слежение за сигналом одного или 

нескольких спутников, светодиод STAT будет подсвечиваться 
зеленым цветом для спутников GPS и оранжевым – ГЛОНАСС 
(количество вспышек соответствует количеству отслеживаемых 
спутников каждой системы). Короткая красная вспышка обозначает 
отсутствие решения навигационной задачи. Местоопределение 
может обеспечиваться при слежении за четырьмя и более 
спутниками. 

• Окончание коротких красных вспышек свидетельствует о том, что, 
приемник определил местоположение и можно начинать съемку. 
Перед началом сбора данных следует дождаться появления 
зеленых и оранжевых вспышек. Это гарантирует то, что приемник 
определил правильные дату и время, а также отслеживает 
достаточное количество спутников, что позволит собрать 
измерительные данные надлежащего качества.  
Процесс захвата спутниковых сигналов обычно занимает менее 
одной минуты. На новом месте, под густой кроной деревьев или 
после перезапуска приемника это может занять несколько минут 

2. Для начала сбора данных нажмите и удерживайте в нажатом 
состоянии кнопку FN более одной секунды, но менее пяти секунд. 

3. Отпустите кнопку FN, когда светодиод REC (recording – запись) станет 
светиться зеленым цветом. Это указывает на то, что файл открылся, и 
запись данных началась. Светодиод вспыхивает каждый раз, когда 
происходит сохранение данных во внутреннюю память. 
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Для настройки процесса сохранения данных 
используйте программу PC-CDU, см. раздел 
“Настройка пользовательского интерфейса 
MINTER”на странице 3-8 или обратитесь к 
Руководству пользователя PC-CDU. 

Завершение сеанса измерений 
Закончите накопление данных при перемещении приемника, копировании 
файлов и при обслуживании прибора. 
1. Нажмите и удерживайте кнопку FN до тех пор, пока светодиод REC не 

погаснет. 
2. Для выключения приемника нажмите и удерживайте в нажатом 

состоянии кнопку питания до тех пор, пока все светодиоды не погаснут, 
после чего отпустите ее. 

Определение координат 
опорной станции статической 
съемкой 
Статическая съемка является классическим методом съемки, хорошо 
подходящим для всех размеров базисов (коротких, средних и длинных). 
По крайней мере, две антенны приемников, центрированные над 
пунктами, одновременно собирают измерительные данные на концах 
базиса в течение некоторого периода времени. Эти два приемника 
должны одновременно отслеживать четыре (или большее количество) 
спутника, записывать данные с одинаковым периодом и иметь одинаковые 
значения угла предельного возвышения. Продолжительность сеанса 
измерений может варьироваться от нескольких минут до нескольких 
часов. Оптимальная продолжительность сеанса измерений определяется 
опытным путем и зависит от следующих факторов: 

• Длины измеряемой базовой линии. 
• Количества спутников в поле зрения. 
• Геометрического фактора (Dilution of Precision, DOP). 
• Расположения антенны. 
• Уровня активности ионосферы. 
• Типа используемых приемников. 
• Требований по точности. 
• Необходимости разрешения неоднозначности фазы несущей. 

В общем случае одночастотные приемники используются для 
определений базовых линий длиной до 15 км. Для определения базовых 
линий длиной свыше 15 км следует применять двухчастотные приемники.
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Двухчастотные приемники имеют два больших преимущества. Во-первых, 
измерения по двум частотам позволяют практически полностью устранить 
ионосферные погрешности в измерениях фазы кода и несущей, 
обеспечивая большую точность, чем одночастотные приемники при 
определении длинных базисов и во время повышенной активности 
ионосферы (ионосферных штормов). Во-вторых, двухчастотным 
приемникам требуется значительно более короткие сеансы измерений для 
получения определений заданной точности. 
После окончания съемки данные, собранные приемниками, могут быть 
загружены в компьютер и обработаны с помощью программного 
обеспечения камеральной обработки (например, Topcon Tools). 

Использование MINTER 
Пользовательский интерфейс MINTER служит для отображения состояния 
приемника и контроля ввода/вывода данных (рисунок 3-14). 

СИД STAT СИД LINK СИД PWR Кнопка FN

Кнопка Питание

СИД REC СИД RX/TX  
Рисунок 3-14. MINTER приемника NET-G3 

С помощью MINTER можно осуществлять разнообразные операции, в том 
числе: 

• Включение и выключение приемника. 
• Включение или выключение записи данных (кнопка FN). 
• Изменение режима отображения. 
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• Отображение светодиодом STAT числа отслеживаемых спутников 
GPS (зеленый цвет) и ГЛОНАСС (оранжевый). 

• Отображение состояния записи данных (светодиод REC). 
• Индикация цикла записи данных (светодиод REC). 
• Индикация состава записываемых данных (светодиод REC), 

статический или динамический, при выполнении кинематической 
съемки c камеральной обработкой. 

• Индикация состояния питания приемника (светодиоды PWR). 
Полное описание пользовательского интерфейса приводится в разделе 
“MINTER” на странице 1-9. 
Включение и выключение приемника производится нажатием на кнопку 
Питание (см. рисунок 3-15). 

• Для включения приемника нажмите и удерживайте в нажатом 
состоянии кнопку Питание до тех пор, пока все светодиоды не 
засветятся. 

• Для выключения приемника нажмите и удерживайте в нажатом 
состоянии кнопку Питание до тех пор, пока все светодиоды не 
погаснут. 

Для включения и выключения приемника
удерживайте кнопку питания одну
секунду в нажатом состоянии  

Кнопка Питание

 
Рисунок 3-15. Функции кнопки питания 

Начало и окончание записи данных производится нажатием на кнопку 
FN в течение 1-5 секунд (см. рисунок 3-16). 

• Во время записи данных светодиод REC светится зеленым цветом. 
Период записи устанавливается с помощью программы PC-CDU, 
подробнее см. раздел “Параметр Recording interval (Интервал 
записи)” на странице 3-10. 

• Всякий раз, когда производится запись данных в память приемника, 
светодиод REC вспыхивает зеленым цветом. 

• Если светодиод REC светится красным цветом, это означает 
переполнение памяти приемника, или возникновение аппаратного 
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отказа или то, что в приемнике установлен неправильный OAF 
(подробнее см. “Файл авторизации опций (OAF)” на странице 1-18). 

С помощью программы PC-CDU устанавливается режим работы кнопки FN 
LED blink mode switch (Переключатель режима светодиода) для 
статической съемки, или Occupation mode switch (Переключатель режима 
съемки) для кинематической съемки. Подробнее см. раздел “Параметр FN 
key mode (Функция кнопки FN)” на странице 3-12. 
При каждом начале или окончании записи открывается новый файл, или 
данные записываются в специально указанный файл. Подробно настройка 
поведения приемника описывается в разделах “Параметр Always append 
to the file (Всегда добавлять к файлу)” на странице 3-11 и “Параметр Files 
creation mode (Режим создания файлов)” на странице 3-11. 

Кнопка FNДля начала и окончания записи данных
удерживайте кнопку FN в нажатом 
состоянии от 1 до 5 секунд

 
Рисунок 3-16. Функции кнопки FN 

Переключение между режимами обработки производится нажатием 
кнопки FUNCTION на время менее 1 секунды (если с помощью PC-CDU 
был разрешен режим Occupation mode switch (Переключатель режима 
съемки)). 
Изменение информационного режима приемника производится 
нажатием кнопки FUNCTION на время менее 1 секунды (если с помощью 
PC-CDU был разрешен режим LED blink mode switch (Переключатель 
режима светодиода)). 
Изменение скорости обмена по последовательному порту приемника 
производится нажатием кнопки FUNCTION на время от 5 до 8 секунд. Эта 
функция полезна, если подсоединенное к приемнику устройство не 
поддерживает установленную для порта скорость обмена. 
После удержания в нажатом состоянии кнопки FUNCTION в течение 5 
секунд индикатор REC подсвечивается красным цветом. Отпустите 
клавишу в течение следующих 3 секунд.
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Анализ отношения сигнал-шум 

Знание уровня мощности сигнала, принимаемого с каждого спутника, 
позволяет оценить его качество. Для этого воспользуйтесь данными 
таблицы 3-4. 

Табл. 3-4. Типичные величины отношения сигнал-шум 
Угол места направления на 
спутник (градусы) 

Канал C/A 
(дБ*Гц) 

Канал Р1 
(дБ*Гц) 

Канал Р2 
(дБ*Гц) 

10 – 20 >35 >10 >10 
20 – 40 >40 >20 >20 
40 – 60 >45 >30 >30 
60 – 90 >50 >40 >40 

Если величина отношения сигнал-шум спутникового сигнала меньше 
указанной в таблице, обратите особое внимание на данные измерений  
этого спутника. Эти измерительные данные могут источником ошибок в 
определении координат и времени. 

Работа с внешними устройствами 
Приемник NET-G3 может быть подключен к различным внешним 
устройствам для калибровки частоты и временной синхронизации, приема 
импульсов внешних событий, метеорологических измерений и передачи 
дифференциальных данных. 
Для того чтобы выбрать устройство, совместимое с NET-G3, обратитесь к 
поставщику оборудования Topcon. Контактная информация находится на 
интернет-сайте TPS: 
 www.topconpositioning.com/static/dealer_pointer.php   
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Глава 4  
Обслуживание 
приемника и 
операции с файлами 
Перед началом камеральной обработки данные, собранные во время  
сеансов полевых измерений, следует загрузить в компьютер. Загрузка и 
удаление файлов также освобождает место для записи данных 
следующей съемки. Процедура очистки энергонезависимой памяти также 
может также понадобиться для устранения затруднений в слежении и при 
устранении отказов канала связи. 
При повышении требований к прибору может потребоваться обновление 
OAF. Разнообразные модули, входящие в состав приемника (платы 
спутникового приемника, питания, радиомодема и Bluetooth) оснащены 
процессорами и, соответственно, исполняют управляющие программы, 
которым может потребоваться обновление. По мере выпуска обновлений 
фирмой TPS загрузка их в приемник обеспечивает максимально полное 
использование его возможностей. 

Копирование файлов с 
внутренней карты памяти 
По окончании съемки следует скопировать собранные файлы с данными 
измерений в компьютер для хранения, обработки и создания резервной 
копии. Имейте также в виду, что память приемника может содержать 
ограниченное количество файлов, и объем данных также лимитирован, 
таким образом, загрузка файлов в компьютер предотвратит потери 
файлов измерений. Описанная ниже процедура переноса данных 
использует программу PC-CDU, но допускается использование любого 
программного обеспечения Topcon, предназначенного для управления 
приемником. 
1. Установите соединение между приемником и компьютером (подробнее 

см. раздел “Подключение приемника к компьютеру” на странице 2-11). 
2. В диалоговом окне Connection Parameters (Параметры 

интерфейсов) выставьте флажок RTS/CTS handshaking 
(квитирование сигналами RTS/CTS) (см. рисунок 4-1 на странице 4-2). 
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Рисунок 4-1. Диалоговое окно Connection Parameters – флажок RTS/CTS 

handshaking 

3. Выберите пункт меню File > File Manager (Файл > Управление 
файлами) и в появившемся диалоговом окне File Manager 
(Управление файлами) выберите вкладку Download path (Каталог 
для загрузки), см. рисунок 5-10. 

 
Рисунок 4-2. Выбор файлов для копирования 

4. Выберите или создайте (с помощью кнопки Create (Создать)) папку, 
предназначенную для хранения файлов. 

5. Выберите вкладку Download files (Файлы для загрузки) и в ней 
отметьте файлы, подлежащие копированию (см. рисунок 4-3 на 
странице 4-3). 
Выбор нескольких подряд расположенных файлов производится с 
удержанием клавиши Shift, а группы из отдельных файлов - клавиши 
Ctrl. 
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Рисунок 4-3. Копирование файлов 

6. Щелкните на кнопке Download (Загрузка). Во время копирования возле 
каждого файла отображаются индикаторы состояния загрузки (см. 
рисунок 4-4). 

• Голубой – файл в очереди загрузки. 
• Красный - файл загружается. 
• Зеленый – файл успешно загружен. 

 
Рисунок 4-4. Индикаторы состояния копирования файлов 

7. По окончании процедуры копирования файлов щелкните на кнопке Exit 
(Выход) диалогового окна File Manager. 

8. Продолжите работу с программой PC-CDU или завершите ее 
выполнение, последовательно выбрав пункты меню File > Disconnect 
и File > Exit. 
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Копирование файлов с 
извлеченной из приемника 
карты памяти 
После того, как карта памяти вынута из приемника, данные могут быть 
скопированы с помощью программы Topcon Link. Устройство чтения CF 
карт должно быть подключено к компьютеру. Для доступа к содержимому 
карты из программы Topcon Link, карта должна быть отформатирована 
для поддержки устройств Topcon. 

• Ярлык устройства форматированной карты окрашен в красный цвет. 

• Ярлык устройства неформатированной карты окрашен в серый цвет. 

Подробное описание порядка работы с данными, 
записанными на карту памяти, содержится в 
Руководстве пользователя Topcon Link. 

. 
1. Вставьте карту в адаптер чтения карт памяти. 
2. Найдите каталог Topcon Memory Cards (Карты памяти Topcon) и 

щелкните по ярлыку, обозначающему адаптер карт памяти. 
3. Щелкните по ярлыку, обозначающему нужную форматированную карту 

памяти. 
4. После установки карты, выделите и скопируйте или выделите и 

перетащите необходимые файлы в файловую систему компьютера. 

 
Рисунок 4-5. Копирование с карты памяти 
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Удаление файлов с 
внутренней карты памяти 
Карта памяти может содержать ограниченное количество данных. Для 
освобождения пространства под новые данные удалите старые файлы. 
Подробная информация содержится в разделе "Организация памяти 
приемника" на странице 4-6. Далее описывается процесс удаления 
файлов программой PC-CDU, но допускается использование любого 
программного обеспечения Topcon, предназначенного для управления 
приемником. 
Также, можно настроить приемник на автоматическое удаление старых 
файлов (подробнее см. раздел "Параметры Automatic File Rotation Mode 
(AFRM) (Режим автоматического создания файлов)" на странице 3-11). 
1. Установите соединение между приемником и компьютером (подробнее 

см. раздел “Подключение приемника к компьютеру” на странице 2-11). 
2. В диалоговом окне Connection Parameters (Параметры 

интерфейсов) выставьте флажок RTS/CTS handshaking 
(квитирование сигналами RTS/CTS), см. рисунок 4-6. 

 
Рисунок 4-6. Диалоговое окно Connection Parameters – флажок RTS/CTS 

handshaking 
3. Выберите пункт меню File > File Manager (Файл > Управление 

файлами), в появившемся диалоговом окне File Manager 
(Управление файлами) выберите вкладку Download files (Файлы для 
загрузки) и в ней выберите файлы, которые следует удалить, см. 
рисунок 4-7 на странице 4-6.  
Выбор нескольких подряд расположенных файлов производится с 
удержанием клавиши Shift, а группы из отдельных файлов - клавиши 
Ctrl. 

4. Щелкните на кнопке Delete (Удалить), см. рисунок 4-7 на странице 4-6. 
5. Щелкните на кнопке Yes (Да)  в диалоговом окне подтверждения 

удаления файлов. PC-CDU удаляет выбранные файлы. 
6. Щелкните на кнопке Exit (Выход) в диалоговом окне File Manager. 
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7. Продолжите работу с программой PC-CDU или завершите ее 
выполнение, последовательно выбрав пункты меню File > Disconnect и 
File > Exit. 

 
Рисунок 4-7. Удаление файлов 

Организация памяти 
приемника 
При использовании приемника в статических и динамических приложениях 
Вам может понадобиться оценить размер файлов с данными измерений, 
которые записываются в приемник. Конкретный размер файла зависит от 
типа записываемых данных. Приближенный расчет размеров таких 
файлов можно произвести по формулам, приведенным ниже. Эти 
соотношения основаны на размере сообщений, записываемых по 
умолчанию. 

• SS – ориентировочный размер записи одной эпохи данных в файле с 
измерительной информацией (выражается в байтах). 

• N – число спутников, которые отслеживаются в этой эпохе. 
При записи данных только по L1: 

SS = 183+22*N 
При записи данных по L1 и L2: 

SS = 230 + 44*N
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В таблице 4-1 приводится расчетные объемы памяти приемника для 
записи файла данных в течение одного часа. Эта величина определяется 
количеством наблюдаемых спутников и частотой записи. 

Таблица 4-1. Объем памяти, требуемый для записи одночасового файла 
измерений. 

Интервал записи (в секундах) Количество 
спутников 

0,1 1 5 15 30 
Одночастотный двухсистемный приемник 

Необходимое количество памяти 
6 11 Мб 1.1 Мб 221 Кб 74 Кб 37 Кб 
10 14 Мб 1.4 Мб 283 Кб 94 Кб 47 Кб 
14 17 Мб 1.7 Мб 345 Кб 115 Кб 57.5 Кб 
18 20 Мб 2.0 Мб 407 Кб 136 Кб 68 Кб 

Двухчастотный двухсистемный приемник 
Необходимое количество памяти 

6 17 Мб 1.7 Мб 347 Кб 116 Кб 58 Кб 
10 23 Мб 2.3 Мб 471 Кб 157 Кб 78.5 Кб 
14 29 Мб 2.9 Мб 595 Кб 198 Кб 99 Кб 
18 35 Мб 3.5 Мб 720 Кб 240 Кб 120 Кб 
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Управление опциями 
приемника 
Файл Авторизации опций позволяет работу отдельных функции 
приемника: 

• Тип сигнала (L1,L1/L2, и т.д.), с которым будет работать приемник. 

• Количество информации, которое приемник сохранит в памяти. 

• Темп передачи или приема данных. 
Полный список доступных опций и их подробное описание вы можете 
узнать у своего дилера Topcon.

Проверка OAF приемника 
Для уточнения текущего состояния опций приемника используйте 
программу PC-CDU. 
1. Установите соединение между приемником и компьютером (подробнее 

см. раздел “Подключение приемника к компьютеру” на странице 2-11). 
2. Выберите пункт меню Tools > Receiver Options (Инструменты > 

Опции приемника). В диалоговом окне Option Manager (Управление 
опциями) (см. рисунок 4-8 на странице 4-9) содержится следующая 
информация: 

• Option Name (Название опции) – Название/описание опции. 

• Current (Текущий) – текущее состояние опции. 

• Purchased (Приобретенный) – приобретена опция или нет. 

• Leased (Арендованный) - арендована опция или нет. 

• Expiration date (Дата окончания действия) – дата, когда опция будет 
отключена, если действие опции имеет временное ограничение. 

Опции могут быть приобретены или арендованы, столбец Current 
(Текущее) отображает текущее состояние опции: 
• 1 или “-----“ -  встроенное программное обеспечение не 

поддерживает опцию. 
• 0 – опция приемника отключена. 
• Положительное целое число – опция включена. 
• yes (да) или  no (нет) - опция включена или выключена 

соответственно. 
3. После завершения работы щелкните на кнопке Exit (Выход) в 

диалоговом окне Option Manager, затем выберите пункт меню File > 
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Disconnect (Файл > Отключение) для предотвращения конфликтов в 
доступе к последовательному порту. 

 
Рисунок 4-8. Окно Option Manager (Управление опциями) 
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Загрузка OAF 
Дистрибьютор Topcon Positioning System обеспечивает пользователей 
файлами OAF (файл авторизации опций). По всем вопросам, касающимся 
OAF, делайте запросы по e-mail. Пожалуйста, 
указывайте идентификационный номер (ID) приемника, указанном на 
шильдике, закрепленном в нижней части прибора. 
1. Установите соединение между приемником и компьютером (подробнее 

см. раздел “Подключение приемника к компьютеру” на странице 2-11). 
2. Выберите пункт меню Tools > Receiver Options (Инструменты > 

Опции приемника). 
3. Щелкните на кнопке Load (Загрузка) диалогового окна Option Manager 

(см. рисунок 4-8 на странице 4-9), 
4. Выберите каталог, где находится новый файл авторизации опций OAF. 

Эти файлы имеют расширения .jpo или .tpo и уникальны для каждого 
приемника (см. рисунок 4-9). 

 
Рисунок 4-9. Загрузка OAF 

5. Выберите соответствующий файл и щелкните на кнопке Open 
(Открыть) (см. рисунок 4-9). Новые опции приемника будут загружены 
в приемник, и таблица в диалоговом окне Option Manager обновится.  

6. После завершения работы щелкните на кнопке Exit (Выход) в 
диалоговом окне Options Manager, затем выберите пункт меню File > 
Disconnect (Файл > Отключение) для предотвращения конфликтов в 
доступе к последовательному порту. 
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Аппаратный сброс 
Аппаратный сброс (перезапуск) следует выполнять в том случае, если 
приемник не реагирует на нажатия кнопок и/или команды, поступающие по 
интерфейсам. Аппаратный сброс требуется произвести в том случае, если 
приемник, находящийся во включенном состоянии, не реагирует на 
действия оператора. 
 

 

Аппаратный сброс подает питание на приемник 
повторно и не удаляет данные, хранимые в памяти 
преемника. 

 
1. Откройте переднюю  крышку. 
2. Введите в отверстие [разомкнутую] бумажную скрепку или другой 

достаточно тонкий предмет (например, кончик стержня шариковой 
ручки), см. рисунок 4-10. 

3. Плавно нажмите на скрытую в углублении кнопку и удерживайте ее в 
нажатом состоянии примерно одну секунду до тех пор, пока приемник 
не выключится. 

Утопленная кнопка
перезапуска

 
Рисунок 4-10. Аппаратный сброс приемника 
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Очистка энергонезависимой 
памяти (NVRAM) 
В энергонезависимом оперативном запоминающем устройстве (NVRAM) 
приемника хранятся данные, необходимые для слежения за спутниками 
(эфемериды и координаты приемника). Энергонезависимое ОЗУ хранит 
также текущие установки приемника, такие как сведения об антенне, 
минимальный угол места и интервал записи, а также данные о внутренней 
файловой системе приемника. 
Хотя очистка энергонезависимого ОЗУ не является часто используемой 
(или даже рекомендуемой при нормальных условиях эксплуатации) 
операцией, встречаются ситуации, когда очистка энергонезависимого ОЗУ 
может устранить проблемы слежения за спутниками и обмена по 
интерфейсным портам. Очистку энергонезависимого ОЗУ приемника 
можно сравнить с перезапуском операционной системы персонального 
компьютера.  
После очистки энергонезависимого ОЗУ приемнику требуется около 15 
минут для получения новых эфемерид и альманаха. 
В ходе очистки энергонезависимого ОЗУ приемника не происходит 
удаления каких-либо файлов, уже записанных в память приемника. 
Очистка приводит к переустановке настроек приемника к первоначальным 
заводским значениям. 
Следует отметить, что после очистки энергонезависимого ОЗУ в течение 
нескольких секунд светодиод STAT вспыхивает оранжевым цветом, 
показывая, что приемник сканирует память, проверяя файловую систему. 

Использование MINTER для очистки 
NVRAM 
1. Нажмите и отпустите кнопку питания для того, чтобы выключить 

приемник.  
2. Нажмите и не отпускайте кнопку FN. 
3. Нажмите и удерживайте кнопку питания примерно 1 секунду. Отпустите 

кнопку питания, кнопку FN следует удерживать в нажатом состоянии. 
4. Подождите, пока светодиоды STAT и REC не станут зелеными. 
5. Подождите, пока светодиоды STAT и REC не начнут вспыхивать 

оранжевым цветом. 
6. Отпустите кнопку FUNCTION при вспыхивающих оранжевым цветом 

светодиодах STAT и REC.
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Использование PC-CDU для очистки 
NVRAM 
1. Установите соединение между приемником и компьютером (подробнее 

см. раздел “Подключение приемника к компьютеру” на странице 2-11). 
2. Выберите пункт меню Tools > Clear NVRAM (Инструменты > 

Очистить энергонезависимое ОЗУ) (см. рисунок 4-11). 

 
Рисунок 4-11. Очистка NVRAM с помощью PC-CDU 

Светодиод REC будет вспыхивать зеленым и красным цветом; светодиод 
STAT – красным. После окончания очистки приемник автоматически 
разорвет соединение с компьютером. 

Изменение режима работы 
приемника 
Приемник может находиться в трех режимах, два из них – режимы 
отображения, а третий - режим энергосбережения: 

• Normal Mode (Нормальный режим) – стандартный режим съемки. 
• Extended Information Mode (Расширенный режим отображения) – 

используется для проверки работоспособности. 
• Sleep mode (Режим низкого энергопотребления) – используется для 

остановки записи информации, но сохраняет питание приемника для 
быстрого возвращения в рабочий режим. 

Вход в расширенный режим 
отображения 
Расширенный режим отображения используется для тестирования 
приемника. В этом режиме приемник продолжает работать как обычно. 
Светодиод STAT указывает «расширенную» информацию с помощью 
разграничителя.  
В качестве разграничителя используется хорошо различимая двойная 
вспышка, который показывает суммарный результат цикла проведенных 
тестов. Цвет светодиода для разграничителя определяется цветом 
вспышек, характеризующих произведенные тесты, по следующим 
правилам: 

• Оранжевый – по крайней мере, одна из вспышек была оранжевой. 
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• Красный – оранжевых вспышек не было, однако была, по крайней 
мере, одна красная вспышка. 

• Зеленый – во всех остальных случаях. 
За разграничителем следуют шесть вспышек светодиодов, 
соответствующие шести тестам приемника, причем каждая из вспышек 
указывает на следующее: 

Вспышка 1. Достаточно ли данных для местоопределения.  
Вспышка 2. Приемлемо ли отношение сигнал/шум в каналах приема  

сигналов GPS (см. табл. 4-2) 
Вспышка 3. Достаточно ли отношение сигнал/шум в каналах приема  

сигналов ГЛОНАСС (см. табл. 4-2). 
Вспышка 4. Смещение частоты встроенного задающего генератора 

относительно номинала менее трех миллионных частей. 
Вспышка 5. Вариация Аллана встроенного задающего генератора 

менее 2,7*10-10.  
Вспышка 6. Время непрерывного слежения составляет более 15 

минут. 
Таблица 4-2. Приемлемые отношения сигнал/шум 

 CA/L1 P/L1 P/L2 

GPS 51 39 39 

ГЛОНАСС 51 49 40 

Цвет вспышек показывает, что данных для теста недостаточно 
(оранжевый), приемник прошел тест (зеленый) или приемник тест не 
прошел (красный). 
1. Для включения режима расширенного отображения нажмите и быстро 

(в пределах одной секунды) отпустите кнопку FN на передней панели 
приемника. 

2. Следите за разграничителем. Если приемник исправен и антенна 
размещена правильно, то в пределах 15 минут после включения 
питания будут индицироваться исключительно зеленые вспышки. 
Цветовое кодирование результатов тестов и окончательной 
диагностики следующее: 
• зеленый – тест пройден успешно. 
• оранжевый – тест не закончен. 
• красный – некоторые тесты не прошли 

3. Для переключения в нормальный режим отображения нажмите кнопку 
FN.
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Режим низкого энергопотребления 
Режим низкого энергопотребления является штатным состоянием 
“выключено” этого приемника. 
1. Включите приемник. 
2. Нажмите и удерживайте кнопку питания от 4-х, но не более 8-и секунд. 

Светодиод STAT засветится оранжевым цветом. Приемник перейдет в 
режим низкого энергопотребления. 

3. Прием произвольного символа по последовательному интерфейсу 
выведет приемник из этого режима в нормальный режим работы. 

Удержание кнопки Питание в нажатом состоянии 
более 14-и секунд будет проигнорировано (таким 
образом реализована защита от западания кнопки). 

 

Обновление встроенного 
программного обеспечения 
Используйте только последние версии встроенного программного 
обеспечения. Получить последнюю версию встроенного программного 
обеспечения можно через службу технической поддержки. 

В приемнике NET-G3 следует использовать 
встроенное программное обеспечение версии 3.1 
или более новое. 

 

Не пытайтесь загрузить программное обеспечение 
версии более ранней, чем 3.1. 

Программное обеспечение платы приемника распространяется в виде 
архивного файла, который следует распаковать перед загрузкой в 
приемник. Этот файл содержит следующие два файла: 

• ramimage.ldr – файл-образ ОЗУ платы приемника 

• main.ldp – файл-образ флэш-памяти платы приемника 

При обновлении встроенного программного 
обеспечения следует загрузить все файла, причем 
они должны быть взяты из одного пакета. 
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Для обновления встроенного программного обеспечения используется 
программа FLoader, функционирующая в среде Windows. Более подробно 
эта программа описана в “Руководстве пользователя FLoader”. Получить 
программу и ее подробное описание можно у поставщика оборудования. В 
разделе “Установка программы FLoader” на странице 2-6 подробно 
описывается процесс установки Floader на компьютер. 
1. Получите новый пакет встроенного программного обеспечения в 

службе технической поддержки и скопируйте его в компьютер. 
2. Установите соединение между приемником и компьютером (подробнее 

см. раздел “Подключение приемника к компьютеру” на странице 2-11). 
3. Запустите программу FLoader. 
4. Во вкладке Connection (Соединение) выберите последовательный порт 

на компьютере, к которому подстыкован кабель связи с приемником и 
выберите скорость передачи данных (обычно 115200 Бод), см. рисунок 
4-12. 

 
Рисунок 4-12. Главный экран программы FLoader 

5. В программе FLoader выберите вкладку Device, в ней для поля Device 
Type (Тип устройства) выберите значение Receiver (Приемник). После 
этого щелкните на кнопке Get from Device (Опросить устройство) для 
получения сведений об устройстве, см. рисунок 4-13. 

 
Рисунок 4-13. Установка типа устройства 
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6. Выберите вкладку Program (Программа) и установите значение Soft 
Break Capture для поля Capture Method, см. рисунок 4-14. 

 
Рисунок 4-14. Вкладка Program 

7. Выберите файлы образов ОЗУ и флэш-памяти платы приемника, см. 
рисунок 4-14. 

8. Щелкните на кнопке Load (Загрузить) и подождите, пока файлы не 
будут загружены в приемник полностью. 

Если Вы выбрали неправильный файл, в нижней 
части диалогового окна появится сообщение об 
ошибке. Выберите правильный файл. 

9. Выберите пункт меню File > Exit (Файл > Выход). 
10. Очистите энергонезависимую память (см. раздел “Очистка 

энергонезависимой памяти” на странице 5-9) и обновите альманах (см. 
раздел “Сбор альманахов и эфемерид” на странице 2-10). 
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Для заметок: 
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Глава 5  
Устранение 
неисправностей 
Эта глава поможет Вам определить причину некоторых отказов, которые 
могут возникнуть при работе приемника, и устранить их. 

 

Никогда не пытайтесь ремонтировать приемник 
самостоятельно. Нарушение этого требования 
лишает Вас гарантийного обслуживания и может 
привести к повреждению прибора. 

Проверьте прежде всего! 
При обнаружении отказов просим Вас до обращения в службу технической 
поддержки Topcon выполнить следующее: 

• Во-первых, тщательно проверьте все соединения приемника с 
внешними устройствами, чтобы убедиться в их правильности и 
надежности.  

• Особое внимание обратите на исправность кабелей. 
• Проверьте все источники питания. 
• Убедитесь в том, что на компьютер установлено самое последнее 

программное обеспечение. Запросите у поставщика оборудования 
наличие обновлений для встроенного программного обеспечения. 

После чего проделайте следующее: 
• Проведите перезагрузку приемника с помощью PC-CDU, используя 

пункт меню Tools > Reset receiver (Инструменты > Перезагрузка 
приемника). 

• Используя PC-CDU, восстановите начальные заводские установки 
(выберите пункт меню Configuration > Receiver (Настройка > 
Приемник)), в появившемся окне щелкните на кнопке Set all 
parameters to defaults (Принять начальные значения для всех 
параметров). 

• Очистите энергонезависимое ОЗУ (см. раздел “Очистка 
энергонезависимой памяти” на странице 4-12). 

• Проведите инициализацию файловой системы - выберите пункт 
меню Tools > Initialize file system (Инструменты > Инициализация 
файловой системы). Это действие удаляет все файлы с 
измерениями, содержащимися в приемнике. 

Если после выполнения этих действий проблема остается 
неразрешенной, обратитесь к перечисленным ниже разделам 
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Список отказов приемника 
Отказы системы питания прибора: 

"Прибор не включается" см. страницу 5-3. 
Отказы спутникового приемника. 

“Невозможно установить соединение с компьютером или внешним 
контроллером” см. страницу 5-3. 
"Слежение за сигналом спутников не устанавливается в течение 
длительного промежутка времени" см. страницу 5-4. 
“Отслеживается малое количество спутников” см. страницу 5-5. 
“Нет местоопределения кодового DGPS или RTK” см. страницу 5-5. 
“Запись данных не производится” см. страницу 6-8. 
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Отказы системы питания 
Ниже описаны наиболее часто встречающиеся отказы системы питания: 

⇒ Внешний источник питания подсоединен неправильно. 

• Проверьте правильность подключения источника питания. 

• Проверьте чистоту контактов источника питания. 

⇒ Батареи могут быть разряжены (если питание обеспечивается от 
аккумуляторов) или источник питания не обеспечивает достаточную 
мощность. 
Подключите полностью заряженную батарею (или замените 
источник питания) и попробуйте включить приемник повторно. См. 
раздел “Питание приемника” на странице 2-8. 

⇒ При использовании внешнего источника питания кабель мог 
отсоединиться или повредиться. 
Проверьте, подключен ли кабель правильно и не поврежден ли он. 

⇒ Возможен отказ платы питания прибора. 
Убедитесь в том, что внешний источник питания исправен. 

Отказы спутникового 
приемника. 
Ниже описаны наиболее часто встречающиеся отказы: 
Невозможно установить соединение с компьютером или внешним 
контроллером 
Отказы кабельных соединений. 
⇒ Кабель подсоединен неправильно. 

• Проверьте, к нужному ли порту подсоединен ли кабель. 
• Расстыкуйте кабель, после чего вставьте его в разъемы 

повторно. 
• Разъемы прибора описываются в разделах “Приемник NET-G3” 

на странице 1-8 и "Технические характеристики разъемов” на 
странице A-9. 

⇒ Кабель поврежден. 
• Используйте исправный кабель. Свяжитесь с поставщиком 

оборудования для замены кабеля. 
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Отказы общего характера. 
⇒ Используемый для соединения порт приемника не находится в 

командном режиме (Command mode). 
1. Установите соединение компьютера с приемником, используя 

один из свободных портов (подробнее см. раздел “Подключение 
приемника к компьютеру” на странице 2-11). 

2. Выберите пункт меню Configuration > Receiver > Ports 
(Настройка > Приемник > Порты). 

3. Задайте в поле Input (Режим ввода) значение Command 
(Командный). 

Слежение за сигналом спутников не устанавливается в течение 
длительного промежутка времени. 
⇒ В приемнике сохранен устаревший альманах. 

Обновите альманах. Подробнее см. раздел “Сбор альманахов и 
эфемерид” на странице 2-10. 

⇒ Соответствующая опция приемника отключена или время ее 
использования закончилось (для слежения за спутниками L1/L2, 
GPS/GLONASS должны быть разрешены к использованию). 
• Порядок действий при проверке разрешенных опций приемника 

детально описан в разделе “Управление опциями приемника” на 
странице 4-8. 

• Закажите новый файл OAF с нужными опциями (разрешенными 
без ограничения по времени или с продленным сроком 
использования). Обратитесь к поставщику оборудования. 

• Опции подробно описываются в Руководстве пользователя PC-
CDU. 
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Отслеживается малое количество спутников. 
⇒ Значение предельного угла возвышения слишком велико (более 15 

градусов). 
Уменьшите значение предельного угла возвышения, процедура 
описана на странице 3-15. 

⇒ Съемка производится вблизи препятствий (кроны деревьев, высокие 
здания и т.п.). 
• Проверьте использование алгоритмов подавления 

многолучевости. 
1. Запустите программу PC-CDU и установите соединение 

между приемником и компьютером (подробнее см. раздел 
“Подключение приемника к компьютеру” на странице 2-11). 

2. Выберите пункт меню Configuration > Advanced (Настройка 
> Расширенные функции), затем вкладку Multipath 
Reduction (Подавление многолучевости), выставьте оба 
флажка и щелкните на кнопке Apply (Применить). 

• По возможности продолжите выполнение работ на большем 
удалении от препятствий. 

Нет местоопределения кодового DGPS или RTK. 
⇒ В базовую станцию введены неправильные координаты. 

Используя PC-CDU или программное обеспечение полевого сбора 
данных, введите правильные координаты в базовую станцию,. 

⇒ Приемник не настроен в качестве базового или подвижного. 
• Если приемник должен использоваться в качестве базового, 

настройте его соответствующим образом. См. главу 3. 
• Если приемник должен использоваться в качестве подвижного, 

настройте его соответствующим образом. См. главу 3. 
⇒ Соответствующая опция приемника отключена или время ее 

использования закончилось. 
• Порядок действий при проверке разрешенных опций приемника 

детально описан в разделе “Управление опциями приемника” на 
странице 4-8. 

• Закажите новый файл OAF с нужными опциями (разрешенными 
или с продленным сроком использования). Обратитесь к 
поставщику оборудования. 

• Опции подробно описываются в Руководстве пользователя PC-
CDU. 
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⇒ На базовом и подвижном приемниках наблюдается недостаточное 
количество общих спутников. Для решения с разрешением фазовой 
неоднозначности до целых величин должны наблюдаться, по крайней 
мере, пять общих спутников. 
• Обеспечьте использование обеими приемниками одинакового и 

самого последнего альманаха. Подробнее см. раздел “Сбор 
альманахов и эфемерид” на странице 2-10. 

• Проверьте значение предельного угла возвышения на базовом и 
подвижном приемниках - его следует установить одинаковым. 
Процедура установки значения предельного угла возвышения 
описана на странице 3-15. 

⇒ На базовой станции и подвижном приемнике используются разные 
форматы дифференциальных поправок. 
Обеспечьте использование обоими приемниками одинакового 
формата дифференциальных поправок: 
1. Запустите программу PC-CDU и установите соединение между 

приемником и компьютером (подробнее см. раздел 
“Подключение приемника к компьютеру” на странице 2-11). 

2. Выберите пункт меню Configuration > Receiver (Настройка > 
Приемник), затем вкладку Ports (Порты). Используйте для 
обоих приемников одинаковый формат дифференциальных 
поправок. 

⇒ Значение геометрического фактора слишком высоко, взаимное 
положение наблюдаемых спутников неблагоприятно для 
производства измерений. 
Продолжите работы тогда, когда значение геометрического фактора 
уменьшится. 

⇒ Значение предельного угла возвышения более 15 градусов. 
Уменьшите значение предельного угла возвышения, процедура 
описана на странице 3-5. 

Запись данных не производится. 
⇒ Карта памяти не установлена в приемник, или опция записи в память 

отсутствует (время ее использования закончилось). 
• Проверите правильность установки карты памяти. Подробнее см. 

раздел “Установка CF карты” на странице 2-7. 
• Проверьте наличие опции записи в память (memory option). 

Порядок действий при проверке разрешенных опций приемника 
детально описан в разделе “Управление опциями приемника” на 
странице 4-8.



Получение технической поддержки 

P/N 7010-0713 5-7 

⇒ На карте памяти не осталось свободного места. 
• Скопируйте записанные файлы измерений в компьютер и 

сотрите их из памяти приемника для того, чтобы освободить 
место для новых файлов (см. разделы “Копирование файлов с 
внутренней карты памяти” на странице 4-1 и “Удаление файлов с 
внутренней карты памяти” на странице 4-5). 

Разрешите использование режима ARFM (см. раздел “Параметры 
Automatic File Rotation Mode (AFRM) (Режим автоматического 
создания файлов)“ на странице 3-11). 

Получение технической 
поддержки 
Если советы и рекомендации, приведенные в данном Руководстве 
пользователя, не помогли устранить ошибку, обратитесь за помощью в 
службу технической поддержки TPS. 
Просим Вас сначала ознакомиться с разделом "Проверьте прежде всего!" 
на стр. 5-1, что позволит Вам устранить некоторые отказы 
самостоятельно. 

Телефон 
Чтобы связаться со службой технической поддержки TPS по телефону, 
звоните в США: 

1-866-4TOPCON (1-866-486-7266) 
С понедельника по пятницу с 16.00 до 4.00 утра по московскому 
времени. 

 
 
Электронная почта 
Для контакта со службой технической поддержки TPS используйте один из 
следующих адресов электронной почты (Таблица 4-1). 

Таблица 5-1. Адреса электронной почты службы технической поддержки 

Для вопросов, связанных с… Используйте… 
Оборудованием (приемники, антеннами, проч.) Hardware@topcon.com 
GMS+ и 3DMC Psg@topcon.com 
Авторизацией опций Options@topcon.com 
Работой в режиме RTK Rtk@topcon.com 
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PC-CDU Pccdu@topcon.com 
Если затрудняетесь определить тему Support@topcon.com 
  

 

  

Для получения как можно более быстрой и 
эффективной поддержки предоставьте, пожалуйста, 
перечисленные ниже сведения. 

1. Модель устройства и его конфигурацию.  
Для этого в программе CE-CDU выберите пункт меню File > Receiver 
Info (Файл > Данные о приемнике) и щелкните на кнопке Save to file 
(Сохранить в файл). Введите имя файла и перенесите его в 
персональный компьютер. Вложите этот файл в письмо. 

2. Сведения о системе и узлах компьютера, на котором выполнятся ПО 
производства Topcon: версия операционной системы, размер 
оперативной и дисковой памяти, скорость процессора и т.д. 

3. Внешние проявления отказа (или сообщения, отображаемые на 
экране) до и после возникновения ошибки. 

4. Действия, которые Вы предприняли для устранения отказа. Если это, 
возможно, опишите все, что Вы делали, по шагам до того момента, 
когда появляется сообщение об ошибке или иной отказ. 

5. Насколько часто проявляется отказ. 
В большинстве случаев представитель службы технической поддержки 
отвечает в течение 24 часов после получения письма, в зависимости от 
сложности отказа. 

Интернет-сайт 
На сайте Topcon Positioning Systems содержится регулярно обновляемая 
информация о продукции фирмы. В разделе технической поддержки 
имеются ответы на часто задаваемые вопросы, процедуры настройки, 
инструкции к приборам, технической поддержки и т.п. 

Адрес интернет-сайта TPS: www.topconpositioning.com  
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Приложение A 
Технические 
характеристики 
Это изделие производства фирмы TPS является 72-х канальным 
приемником спутниковых навигационных систем (ГНСС) и оснащается 
(заказываемой опционально) сменной картой памяти формата CF. Прибор 
выполнен в защищенном от внешних воздействий алюминиевом корпусе, 
оснащенном пользовательским интерфейсом MINTER и разъемами 
внешних соединителей. 

Эксплуатационные характеристики даны для 
следующих условий наблюдения: приемник 
отслеживает не менее 6 спутников GPS с углами 
места не менее 15 градусов, выполнены все 
рекомендованные в этом руководстве процедуры. 

 
Допускается ухудшение эксплуатационных 
характеристик в условиях высокой многолучевости, 
при высоком значении геометрического фактора 
(PDOP), а также в периоды повышенной 
ионосферной активности. 

 
Используйте дополнительные процедуры контроля 
качества измерений при производстве работ в 
условиях высокой многолучевости и под густой 
листвой. 
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Габаритные размеры NET-G3. 
На рисунке А-1 приводятся габаритные размеры и положение посадочных 
мест приемника NET-G3. 

 

Размеры даны в дюймах, в квадратных скобках – в 
миллиметрах, 1 дюйм = 25.4 мм. 

 

[95,3]

[31,6]

[165,1]

[126.0]

[170,0][279,4]

4 отверстия [3,5] 
с резьбой 8-32 
UNC

 
Рисунок A-5-1. Габаритный чертеж приемника NET-G3 

В соответствии с этим чертежом просверлите отверстия в основании, 
предназначенном для постоянного крепления прибора, после чего 
закрепите прибор на четырех винтах с дюймовой резьбой 8-32 UNC. 
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Технические характеристики 
приемника 
Далее приводятся характеристики приемника и его отдельных узлов. 

Общие характеристики 
В таблице А-1 перечислены общие характеристики приемника. 

Таблица A-1. Общие характеристики приемника 

Конструктивное исполнение. 

Корпус. Алюминиевый профиль, степень защиты IP67. 
Цвет. Желтый и серый цвета фирмы Topcon 
Габаритные размеры. Ширина:166 Высота:93 Глубина: 275 мм 
Масса. 2,4 кг. 
Антенна. Внешняя. 
Контроллер. Внешний MINTER. 

Кнопки. 

Две кнопки: 
Power (питание) – On/Off (Вкл./Выкл.) 
FN (Функциональная) – начало/конец записи 
данных; переключение информационных режимов 
отображения. 

Светодиоды. 

Шесть светодиодов: 
STAT – состояние спутников и приемника. 
REC – состояние записи и данных. 
BATT – состояние батарей. 
RX – состояние модема. 
PWR (2 шт.) - состояние источников питания 

Устойчивость к внешним воздействиям. 

Рабочая температура. От -40 до +65 градусов Цельсия. 

Температура хранения. От -40 до +75 градусов Цельсия. 

Влажность 100% без конденсации. 
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Питание. 

Внешнее питание. 2 разъема подключения внешних источников 
питания. 

Напряжение питания. От 6 до 28 Вольт постоянного тока. 

Потребляемая 
мощность. 

Средняя - 4 Вт 
Максимальная - 5 Вт 

На печатной плате 
приемника. 

Встроенная батарея для сохранения времени и 
данных альманаха; срок службы не менее 10 лет.  

Обмен данными. 

Порты связи. 

4 высокоскоростных последовательных RS232 порта 
(1 разъем ODU-MINI-SNAP и 3 шт. DE-9),  
1 USB порт (разъем Mini-B) 
1 Ethernet порт (разъем ODU-MINI-SNAP).   

Характеристики 
портов. 

Порты RS-232: 
Скорость передачи данных [Бод]: 460800, 

230400,115200 (начальная установка), 57600, 
38400, 19200, 9600, 4800, 2400,1200, 600, 300. 

Квитирование: RTS/CTS 
Размер слова: 7 и 8 (начальная установка). 
Стоп-биты: 1 (начальная установка), 2 
Четность: отсутствует (начальная установка), 
проверка на четность, проверка на нечетность.  

USB порт 
Full speed: 12 Мбит/сек. 

Ethernet порт 
Полный дуплекс, 10BASE-T. 

Разъемы. 

2 шт. питания, 4 шт. RS-232, USB, Ethernet, разъем 
подключения антенны GPS, разъем выхода метки 
времени, разъем ввода импульса внешнего события, 
разъем подключения внешнего генератора. 

MINTER. 

6 светодиодов (подробнее см. раздел “Светодиоды” 
на странице А-3). 
Кнопка включения/выключения (кнопка Питание), 
Управление записью данных (кнопка FN). 
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Типы и характеристики данных. 

 

Темп измерений (фаз кода и несущей) и 
местоопределений до 20 Гц; 
Точность измерения фазы кода 10 см, фазы 
несущей – 0.1 мм; 
Вход и выход данных формата RTCM версий 2.1, 
2.2, 2.3 и 3.0; 
Модели геоида и магнитного поля; 
RAIM (автономный мониторинг целостности); 
Поддержка разных систем координат; 
Выдача местоопределений в координатах 
проекции; 
Поддержка форматов CMR и CMR+. 

Возможности измерительных каналов. 

 
Подавление влияния многолучевости; 
Слежение за сигналами спутников WAAS; 
Настраиваемые параметры петель слежения за 
фазой несущей (PLL) и кодовой задержки (DLL); 

NMEA. 

Версия протокола Вывод в соответствии с 2.1, 2.2, 2.3 и 3.0 

Сообщения GGA, GLL, GNS, GRS, GSA, GST, GSV, HDT, RMC, 
VTG, ROT, GMP 

Интервал выдачи 1 Гц (стандартно); 5, 10 и 20 Гц (опция) 

DGPS. 
Формат данных. RTCM 2.1, 2.2, 2.3 и 3.0. 

Типы сообщений RTCM. 1, 3, 9, 31, 32, 34 по выбору оператора. 

Темп решения 
навигационной задачи. 1 Гц (стандартно); 5, 10 и 20 Гц (опция). 

Темп выдачи поправок. 1 Гц (стандартно); 5, 10 и 20 Гц (опция). 

Предельный угол места. От 0 до 90 градусов, не зависит от аналогичного 
параметра для записи данных. 

DGPS с использованием 
нескольких базовых 
станций. 

Выбор способа использования 
дифференциальных поправок: Nearest 
(Ближайшая), Mix (Смешанный), Best (Лучшая) – 
опция. 
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RTK 

Формат данных. CMR2/CMR+ (совместим с изделиями ф. Trimble), 
RTCM SC104 версий 2.2, 2.3 и 3.0. 

Типы сообщений RTCM. 3, 18, 19, 20, 21, 22 по выбору оператора. 
Разрешение 
неоднозначности. OTF (L1, L1/L2). 

Длина базиса. До 50 км утром и вечером. 
До 32 км в полдень. 

Время инициализации. 
От 5 секунд до 10 минут в зависимости от длины 
базовой линии и условий многолучевого 
распространения. 

Темп выдачи поправок 
формата RTCM/CMR. 1 Гц (стандартно); 5, 10 и 20 Гц (опция). 

Предельный угол места. От 0 до 90 градусов, не зависит от аналогичного 
параметра для записи данных. 

Тип решения. С задержкой (синхронное); 
Экстраполированное (а синхронное). 

Темп решения 
навигационной задачи. 1 Гц (стандартно); 5, 10 и 20 Гц (опция). 

Задержка выдачи 
навигационного решения. 

Режим с задержкой – от 20 мс до 20 с, зависит от 
задержки, с которой принимаются данные от 
базового приемника. 
Режим с экстраполяцией – от 2- до 30 мс. 

Запись данных измерений 

При работе в режиме RTK приемник способен 
записывать данные измерений с темпом, не 
совпадающим с темпом решения навигационной 
задачи. 

Данные о состоянии. 

Тип решения (Fix, Float), геометрический фактор, 
состояние канала связи, задержка полученных 
данных, наблюдаемое совместно созвездие, 
относительное количество полных решений. 

Результаты 
местоопределения. 

Координаты и оценки их точности (с.к.о. 
горизонтальных и вертикальной координат), 
ковариационная матрица. 

Уровень принятия 
решения о разрешении 
фазовой 
неоднозначности. 

Выбираемый уровень 
Низкий – 95%, Средний – 99.5%, Высокий – 99.9%. 

Режимы съемки 

Базовый или подвижный 
приемники. 

Статический; 
Кинематический с остановками; 
RTK (Кинематический реального времени); 
DGPS (дифференциальный по кодовым 
измерениям); 
WAAS/EGNOS DGPS. 
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Точность съемки в режиме. 
Статический (в т.ч. 
“быстрый”). 

для L1+L2 – в плане: 3мм + 0.5мм/км 
по высоте: 5мм + 0.5 мм/км 

Кинематический с 
камеральной обработкой, 
RTK 

для L1+L2, L1 – в плане: 10мм + 1.0мм/км 
по высоте: 15мм + 1.0 мм/км 

DGPS (по измерениям фазы 
кода) 

В камеральной обработке: с.к.о. горизонтальных 
координат менее 0.25м 
DGPS/RTCM (в реальном времени): с.к.о. 
горизонтальных координат менее 0.25м 

Время местоопределения 
“Холодный” старт 
“Теплый” старт 
Восстановление слежения. 

менее 60 с. 
менее 10 с. 
менее 1 с. 

 

Технические характеристики платы 
спутникового приемника 
В таблице А-2 приведены общие характеристики платы спутникового 
приемника. 

Таблица А-2. Общие характеристики платы спутникового приемника 

Тип приемника (устанавливается загрузкой OAF) 

Внутренняя плата: 
Euro-160ЗPII 

GPS: L1 C/A и P – коды, L2, L2C, L5. 
ГЛОНАСС: L1, L2 (кодовые и фазовые 
измерения) 
GALILEO: E2-L1-E1, E5a 

Характеристики слежения. 
Стандартные каналы. 72 канала, универсальные G, GG, GD, GGD 
Дополнительно. Cindrella days (см. страницу А-8). 

Отслеживаемые сигналы. GPS/ГЛОНАСС, L1/L2 C/A, L5, GALILEO, P-
код и фаза несущей, WAAS/EGNOS 

Функции слежения. 

Подавление многолучевости. По коду и фазе несущей. 
Настраиваемые параметры 
PLL/DLL. Полоса частот и порядок фильтра. 

Интервал сглаживания. Измерений кода и фазы несущей. 

SBAS WAAS (опция) 
EGNOS (опция) 
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Типы и характеристики данных. 
Поддерживаемые форматы 
данных. TPS, NMEA, RTCM, CMR, BINEX 

Характеристики. 

Темп измерений (фаз кода и несущей) и 
местоопределений до 20 Гц; 
Точность измерения фазы кода 10 см, фазы 
несущей – 0.1 мм; 
Вход и выход данных формата RTCM версий 
2.1, 2.2, 2.3 и 3.0; 
Модели геоида и магнитного поля; 
RAIM (автономный мониторинг целостности); 
Поддержка разных систем координат; 
Выдача местоопределений в координатах 
проекции; 
Поддержка форматов CMR и CMR+. 

Память. 

Внутренняя память. Съемная карта памяти формата SD. 

Емкость памяти. 
В зависимости от используемой карты 
SD/MMC (Secure Digital/Multi-Media Card), в 
настоящий момент поддерживается до 1 Гб. 

Продолжительность записи. 53 часа (8 Мб, 15 сек, L1/L2, 7 спутников). 

Интервал записи. От 0,05 до 86400 секунд, в зависимости от 
приобретенных опций. 

Cindrella days - опция, которая превращает одночастотный GPS-приемник 
в двухчастотный GPS+ГЛОНАСС приемник на 24 часа каждый вторник, 
начиная с полуночи по шкале времени GPS. За более подробной 
информацией и конкретными датами дней Cindrella обратитесь на 
интернет-сайт Topcon. 
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Технические характеристики 
разъемов 
Приемник NET-G3 оснащен следующими разъемами: 

• Питание (2шт) • Антенна GPS 
• RS-232C (1шт. тип ODU, 3 шт. 

тип DE-9) • 1 PPS 

• USB • Входа внешнего импульса 

• Ethernet • Входа внешнего генератора 

Разъем питания 
Разъем питания (см. рисунок А-1) - герметичный пятиштырьковый 
гнездовой фирмы ODU p/n G80F1C-T05QF00-0000. 

 
Рисунок А-2.  Разъем питания 

В таблице А-3 приведено описание разъема питания. 
Таблица А-3. Описание разъема питания 

Штырек Сигнал Направление Примечание 

1 Power_INP (Питание 
Вход). Силовой 6 - 28 Вольт 

постоянного тока 

2 Power_INP (Питание 
Вход). Силовой 6 - 28 Вольт 

постоянного тока 

3 Power_GND (Питание 
Общий). Силовой Общий 

4 Power_GND (Питание 
Общий). Силовой Общий 

5 Aux_GND (Питание 
Дополнительный). Силовой 6 - 28 Вольт 

постоянного тока 
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Разъем последовательного порта 
RS-232 
Разъемы последовательного интерфейса RS-232, установленный на 
передней панели – (см. рисунок А-3) - герметичный семиштырьковый 
гнездовой фирмы ODU p/n G80F1C-T07QC00-0000. 

 
Рисунок. А-3. Разъем RS232. 

В таблице А-4 приведено описание разъема RS232. 
Таблица А-4. Описание разъема RS232. 

Штырек Сигнал Направление Примечание 

1 Ext_PWR  Выход Силовой 
Выход напряжения 
питания (от 6 до 28 Вольт 
пост. тока, 0.5А макс.) 

2 Общий  Сигнальный общий. 

3 CTS Вход Передача возможна. 

4 RTS Выход Запрос на передачу. 

5 RXD  Вход Прием данных. 

6 TXD Выход Передача данных. 

7   Не используется 

Порты интерфейса RS-232C на задней панели выполнены в 
герметизированных 9-и штырьковых разъемах типа D-SUB[miniature]. 

 

Рисунок A-4. Разъем последовательного интерфейса RS-232 
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В таблице А-5 приведено описание разъема RS232. 
Таблица А-5. Описание разъема RS232. 

Штырек Сигнал Направление Примечание 

1   Не используется. 

2 RXD  Вход Прием данных. 

3 TXD Выход Передача данных. 

4 Общий  Сигнальный общий. 

5   Не используется. 

6   Не используется. 

7 RTS Выход Запрос на передачу. 

8 CTS Вход Передача возможна. 

9   Не используется. 

Разъем USB 
Разъем USB – MINI-B (см. рисунок А-5). 

 
Рисунок A-5. Разъем USB 

В таблице А-6 приведено описание разъема USB. 

Таблица А-6. Описание разъема USB 

Штырек Сигнал Направление Примечание 

1 VDD Силовой Шина питания USB  

2 V+ Двунаправленный Данные, - 

3 V+ Двунаправленный Данные, + 
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4   Не используется 

5 GND Силовой Общий провод 

Разъем Ethernet 
Разъем Ethernet – 12-и штырьковый ODU-MINI-SNAP (см. рисунок А-6). 

 
Рисунок A-6. Разъем Ethernet 

В таблице А-7 приведено описание разъема Ethernet. 

Таблица А-7. Описание разъема Ethernet 

Штырек Сигнал Направление Примечание 

1 LAN TXD+ Выход Передача+ 

2 LAN TXD- Выход Передача- 

3 LAN RXD+ Вход Прием+ 

4 LAN RXD- Вход Прием- 

5   Не используется 

6   Не используется 

7   Не используется 

8   Не используется 

9   Не используется 

10   Не используется 
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11   Не используется 

12   Не используется 

Разъем антенны GPS 
Разъем для подключения антенны приема сигналов спутниковых 
навигационных систем - ВЧ коаксиальный, типа N. 

Таблица А-8. Описание разъема Ethernet 

Тип Сигнал Направление Примечание 

N Ant_IN Вход 

Вход ВЧ сигнала от 
МШУ, встроенного в 
антенну. Ток 60 мА при 
напряжении 5 Вольт 
постоянного тока 

Разъем сигнала 1PPS 
Разъем, используемый для вывода сигнала 1 PPS – гнездовой 
коаксиальный типа BNC, номер по каталогу Kings Electronics – KC-79-108. 

Таблица А-9. Описание разъема 1PPS 

Тип разъема Гнездовой BNC 

Полярность Положительный импульс  

Уровень сигнала >=2 Вольт, TTL уровень в нагрузке 50 Ом 

Длительность 
переднего фронта Не более 3 нс. 

Длительность 
заднего фронта Не более 3 нс. 

Рабочий фронт Передний или задний по выбору оператора 

Точность 
синхроимпульса 

+- 2.5 нс., достигается при определенных условиях. 
Подробности предоставляются при обращении в службу 
технической поддержки Topcon.  

Продолжительность 
периода выдачи От 10 до 1000000000 мс 

Вводимая задержка 
выдачи 
синхроимпульса 

От -500000000 до +500000000 мс, -500000 до +500000 
нс. 
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Опорная шкала 
времени GPS, ГЛОНАСС, UTC (USNO), UTC(SU) 

Разъем входа внешнего импульса 
Разъем, используемый для ввода сигнала внешнего импульса – гнездовой 
коаксиальный типа BNC, номер по каталогу Kings Electronics – KC-79-108. 

Таблица А-10. Описание разъема 1PPS 

Тип разъема Гнездовой BNC 

Полярность Положительный или отрицательный импульс  

Уровни логических 
сигналов 

Низкий уровень (лог. “0”) – от –40 до 0.8 Вольт; 
Высокий уровень (лог. “1”) – от 1,40 до +40 Вольт; 

Входной импеданс 
Для сигналов в пределах от –40 до 0 Вольт и от 3.3 до 
+40 Вольт – 2 кОм, в пределах от 0 до 3.3 Вольт – не 
менее 100 кОм 

Ширина импульса Не менее 100 нс. 

Рабочий фронт Передний или задний по выбору оператора 

Точность 
синхроимпульса 

+- 2.5 нс., достигается при определенных условиях. 
Подробности предоставляются при обращении в службу 
технической поддержки Topcon.  

Опорная шкала 
времени GPS, ГЛОНАСС, UTC (USNO), UTC(SU) 
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Разъем внешнего генератора 
Разъем, используемый для сигнала внешнего генератора – гнездовой 
коаксиальный типа BNC, номер по каталогу Kings Electronics – KC-79-108. 

Таблица А-11. Описание разъема 1PPS 

Выходной сигнал 

Тип разъема Гнездовой BNC 

Частота 20 МГц 

Амплитуда 0.6 Вольт (двойное пиковое значение) на нагрузке 50 Ом 

Форма сигнала Гармонический 

Уровень гармоник -19 dB от уровня основной гармоники 

Паразитные 
составляющие -70 dB от уровня основной гармоники 

Входной сигнал 

Тип разъема Гнездовой BNC 

Частота 5/10/20 МГц 

Уровень входного 
сигнала 

От 0.5 до 3 Вольт (двойное пиковое значение) на 
нагрузке 50 Ом 
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Карты памяти CF, пригодные к 
использованию с NET-G3 
Карты памяти CF, перечисленные в приведенном ниже списке, были 
протестированы с приемником NET-G3 и могут быть использованы с 
приемником. Перед использованием карты памяти, не входящей в список, 
проконсультируйтесь со службой технической поддержки Topcon.

Таблица А-12. Карты памяти CF, пригодные к использованию с NET-G3 

Размер памяти 
(Мб) 

Артикул по 
каталогу Topcon 

Артикул по каталогу 
фирмы-производителя 

SanDisk 

16 22-006011-16 SDCFBI-16-101 

32 22-006011-32 
SDCFBI-32-101 
SDCFBI-32-201-00 
SDCFBI-32-201-01 

64 22-006011-64 SDCFBI-64-101 
SDCFBI-64-201-00 

80 22-006011-80 SDCFBI-80-101 

96 22-006011-96 SDCFBI-96-101 

128 22-006011-128 SDCFBI-128-101 
SDCFBI-128-201-00 

160 22-006011-160 SDCFBI-160-101 

192 22-006011-192 SDCFBI-192-101 

256 22-006011-256 SDCFBI-256-201-00 

512 22-006011-512 SDCFBI-512-201-00 

1024 22-006011-001 SDCFBI-1024-201-00 

SiliconSystems 

32 22-006011-32 SSD-C32MI-3012 

128 22-006011-128 SSD-C12MI-3012 
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256 22-006011-256 SSD-C25MI-3012 

512 22-006011-512 SSD-C51MI-3012 

1024 22-006011-001 SSD-C01GI-3012 

White Electronis Design 

128 22-006011-128 WED7P128CFA7000I25 

256 22-006011-256 WED7P256CFA7000I25 

512 22-006011-512 WED7P512CFA7000I25 

1024 22-006011-001 WED7P1G0CFA7000I25 
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Для заметок: 
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Приложение B 
Меры безопасности 
 

Предупреждения общего 
характера 
 

 

Приемники TPS предназначены для геодезической 
съемки и относящихся к ней задач (например, 
определения координат, измерение расстояний, 
углов и глубин и записи результатов таких 
измерений). Эти изделия нельзя использовать: 
• Без тщательного изучения и четкого понимания 

этого Руководства. 
• После отключения систем безопасности или 

внесения  изменений в изделие. 
• С нештатными принадлежностями. 
• Без соблюдения соответствующих мер 

безопасности при проведении работ. 
• Вопреки установленным законам, нормам и 

правилам 

 

 

TPS приемники нельзя использовать в опасных 
окружающих условиях. Использование приемника под 
дождем и снегом допустимо лишь в течение 
ограниченного времени. 
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Предупреждения по 
применению 
 

 

Если это изделие было подвергнуто ударному 
воздействию, модифицировано, перевозилось без 
надлежащей упаковки или с ним обращались без должной 
аккуратности, измерения могут содержать погрешности. 
 
Пользователь должен периодически поверять изделие 
для того, чтобы удостовериться в том, что точность 
проводимых им измерений соответствует заявленным 
техническим характеристикам.  
 
Немедленно информируйте TPS о неправильной работе 
изделия. 

 

 

Ремонт и обслуживание изделия должны проводиться 
исключительно в сервисных центрах, сертифицированных 
TPS 
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Приложение C 
Нормативные 
сведения 
В этом приложении содержится информация о соответствии данного 
изделия официальным нормативным требованиям. 

Соответствие требованиям 
FCC 
Это устройство соответствует правилам FCC, Часть 15. Устройство в 
рабочем состоянии должно соответствовать следующим двум условиям: 
1. Данное устройство не должно вызывать вредных помех. 
2. Это устройство должно воспринимать любую помеху, включая помехи, 

которые могут вызвать нежелательные сбои в работе. 
Это оборудование было испытано и признано соответствующим по 
ограничениям для цифровых устройств класса "В", в соответствии с 
правилами FCC, Часть 15. Эти ограничения предназначены для 
обеспечения обоснованной защиты от вредных помех при стационарной 
установке. Это оборудование генерирует, использует и может излучать 
электромагнитные волны в радиочастотном диапазоне, и, если 
устанавливается не в соответствии с инструкциями, может вызвать 
помехи для радиосвязи. Однако нет никакой гарантии в том, что вредные 
помехи не возникнут в каждом конкретном случае. 
Если это оборудование вызывает помехи для радио или телевизионного 
приема, что может быть установлено включением и выключением 
аппаратуры, пользователь может попытаться устранить наведенные 
помехи одним или несколькими перечисленными ниже способами: 

• Изменить ориентацию или местоположение принимающей антенны. 

• Переместить оборудование от приемника. 

• Запитать оборудование и приемник от разных сетевых розеток. 
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• Проконсультируйтесь с продавцом оборудования или опытным 
радиотехником для получения конкретных рекомендаций. 

Любые изменения или модификации, примененные к 
оборудованию без выраженного одобрения стороной, 
ответственной за соответствие этим требованиям, 
может аннулировать Ваше право на эксплуатацию 
этого оборудования. 

Соответствие требованиям 
стран Европейского 
содружества. 
Аппаратура, описанная в этом руководстве, соответствует нормативам 
R&TTE и EMC, принятым в странах Европейского Содружества. 

Директива WEEE 

 

Согласно директиве WEEE (WEEE - Waste Electrical and Electronic 
Equipment – директива ЕС по утилизации электрического и электронного 
оборудования) этот символ обозначает то, что данная аппаратура не 
может быть утилизирована как бытовые отходы. Правильным образом 
утилизировав это устройство, Вы поможете предотвратить вред 
окружающей среде и здоровью людей, который в противном случае будет 
вызван неправильной переработкой этого устройства. За более подробной 
информацией обращайтесь к продавцу этого оборудования.
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Приложение D 
Гарантийные 
обязательства 
Лазерные и электронные геодезические инструменты компании TPS 
гарантированы от использования дефектных материалов и 
работоспособны при эксплуатации согласно этому Руководству. Гарантия 
действительна в течение периода времени, указанного на гарантийном 
талоне (прилагается к изделию, приобретенному у авторизированного 
дилера TPS).1  
В течение гарантийного периода TPS, по своему выбору, бесплатно 
восстановит или заменит неисправное оборудование. Запасные части и 
изделия будут заменены новыми или отремонтированы на основании 
обмена на неисправное оборудование. Эта ограниченная гарантия не 
распространяется на услуги по восстановлению изделия, неисправного из-
за несчастного случая, стихийного бедствия, неправильной эксплуатации 
или несанкционированной модификации. 
Гарантийное обслуживание может быть получено от уполномоченного на 
производство ремонта представителя TPS. Если неисправное изделие 
поставляется почтой, покупатель обязуется застраховать изделие или 
принимает риск потери или повреждения во время транспортировки. При 
пересылке покупатель должен использовать оригинальную упаковку или 
эквивалентную. К направляемому в гарантийный ремонт изделию следует 
приложить письмо, описывающее отказ и/или дефект изделия. 
TPS ни при каких условиях не принимает на себя обязательств возмещать 
убытки или издержки, в том числе упущенную выгоду, потери денежных 
средств, или другие прямые или косвенные убытки, могущие возникнуть от 
использования или невозможности использования изделия. 
 
 
 

                                         
1 Гарантия на батареи, зарядные устройства и кабели производства 
Topcon составляет 90 дней. 
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Для заметок: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 




